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Purpose

These work instructions describe the process for creating, modifying and inactivating a Customer Master Data record in BAAN.  It applies to both Parent and Child 
Customers. It applies to the setup of Sold-To, Ship-To, Invoice-To and Pay-By Customers.

These work instructions cover the process for Customer Maintenance everywhere.

Process Flow

Process description for retained organization

blocked URL

Steps for Sales Reps

Requests for customer setups should be submitted via Freshdesk portal or sent to DATA MANAGEMENT RIGA - datamanage@solvay.com

 

Steps for Customers Service Reps

https://lh6.googleusercontent.com/vxe7V3BLs02sUb-oPME4dldc4iBPDKaWm4fOlaVrize-DC_quqexAiuRf5eci9PmBu9lAsFW1m7avhne-2p_sI_hCYyT-6RcRDdEtnStfiReFvTWugX-zoNypwHpqj9X_TzPBEI
mailto:datamanage@solvay.com
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Requests for customer setups should be submitted via Freshdesk portal or sent to DATA MANAGEMENT RIGA - datamanage@solvay.com

Steps for Credit Control

DMO sets ups customers in all roles except for ‘Invoice-To’

Process description for SSC

Validation of the VAT-number (Europe)

NOTE! There is no need to request tax IDs (W-9 forms) for US accounts; if they are received, they should be forwarded to the tax department - 
(do not fill in US customer tax IDs anywhere in the BP).

When VAT# is applicable (for customers located in Europe; not mandatory for UK-located customers created for Company 187), validate it by using Validation for 
Customer and Vendor Master Data. 

General Information on BAAN

Business Partner (BP):

Business Partner (BP) is the term used to identify customers, suppliers and employees.  A business partner can be a customer, a supplier, or an employee. CEM
has created unique numbering schemes for the different types of BP’s.  If a supplier is also a customer two unique BP’s will be created based on the chart below:

BP Type Numbering Scheme Addresses

Vendors (suppliers) 100 SUP

Employees 200 EMP

Customers 500; 805 (for China) CUS; CHC (for China)

Roles

Business Partner roles determine how the business partner can be used.  There are 8 roles available for a business partner. Four of the roles are customer related
and four of the roles are supplier/employee related.  As mentioned above, CEM will not mix customer and supplier roles. 

Type Role Description

Customer Sold-to Business Partner ordering the goods or services.   This is the 1st field entered on the sales order and will determine which Ship-to, Invoice-to, and Pay-by 
business partners can be selected.

Customer Ship-to Business Partner to which product is shipped.  

Customer Invoice-
to

Business Partner to which you mail the invoices.  Credit limits are maintained in this role. Accounts Receivable is also tracked by the Invoice-to role.

Customer Pay-by Business Partner from which you receive payments.  Will usually be equal to ‘Invoice-to’.  

Vendor B u y
From

Business Partner from which you are ordering goods (PO is sent to this BP). This is the 1st field entered on the purchase order and will determine which 
Ship From, Invoice From, Pay To business partners can be selected.

Vendor Ship-
from

Business Partner that ships the material.  

Vendor Invoice-
from 

Business Partner that sends the invoice.  

Vendor Pay-to The Business Partner to which you pay invoices.  

Address Codes

Baan does not store physical addresses in the master files.  Only address codes, which refer to a ‘Address’ Table, are entered.  When setting up a new business
partner, the address (i.e. 2085 E. Technology Circle) must be entered into the system using the ‘Maintain Addresses’ session.  A code is assigned by the system,
which can then be used in the business partner.

blocked URLblocked URL

mailto:datamanage@solvay.com
https://wiki.syensqo.com/display/DO/Validations+For+Customer+And+Vendor+Master+Data
https://wiki.syensqo.com/display/DO/Validations+For+Customer+And+Vendor+Master+Data
https://lh6.googleusercontent.com/xto2VF0WFOUJqJjhiiABXYLP5lApWZBNFK28vln0ZTeP02D6leWm0StsPrGTPxsbTCDEuAnm8Eca1pwjCZPX81NwJLQ0zchKMNw47PTa_M1M64wlcCayZMvA7Df67Ks1nDDwty4
https://lh5.googleusercontent.com/UAzNNBxcfDP7ngZXeVSQj_g63lqoj53Fc8e5GDJQmWXdcdiSjbtOJN8aQhVV94XH6qDYBHnAvqPOILF7Iq8S4vHza3B3XAYCDXkKLm607H8A9EFBszOeYLXwqFGlHpZGzm8s-ew
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Extreme caution must be used when addresses are changed.  You cannot change main information on existing address (only e-mail, telephone numbers) because
an address code can be used by many business partners, so changing one address may result in changes to many business partners. For such purposes, please
use BAAN customer query in order to determine if the CUS code is used by other BP.

Accessing BAAN

The first step is accessing BAAN. On your desktop or on the desktop start menu you double-click the icon: 

blocked URL

The following pop-up will appear:

Complete:

Username 
Password 
Select blocked URL

blocked URL

You enter into the main menu of BAAN. Before you go choosing any menu in the menu browser, you must select the company for which you must change, 
maintain or create the business partner. In the main menu bar on the top of the screen, select Options >Change Company.

blocked URL

Select the necessary company code:

blocked URL

Company codes to be used for customers: 

Region, 
Country

or 
Business

Company Number Plants

USA - 
CEM

100 (to be used for all customers located in the United States, Canada, Australia, New Zealand or Latin 
America and not created for China – Co: 775)

Havre de Grace, MD (70) Winona, MN (40) Greenville, 
TX (30) Anaheim, CA (20)

Orange, CA (20)

D’ Air—Anaheim, CA (12) Tempe, AZ  (10) Kalamazoo, 
MI (46)

China 775 (to be used for all customers created for China – Co: 775)* Fengxian, China (80)

UK -
Wrexham

187 (to be used for all customers located in Europe,  Middle East (India included) or Africa and not 
created for China – Co: 775)

* Company 180 (CSS Shanghai) was previously used for China, but it was replaced by company 775 (CEM Shanghai) after the Coatings separation in early 2013. 
Co: 180 was sold and closed.

Accessing the Business Partners Menu

In the main menu, select the following: Menu Browser>DMO Role>Business Partner Maint Suppliers>Business Partners.

Remark: do not use the icons blocked URLon the initial screen.

blocked URL

Receiving a request

A request will be received from Customer Service or from Sales (Account Managers) by e-mail or through Freshdesk portal, accompanied with the necessary
documentation.

For a NEW BP SETUP or RE-ACTIVATION OF A BP the documents should include:

1. Cytec common credit application form 

Credit application form must be filled out and signed by customer. Form should be provided regardless of payment terms requested (also for sample orders).

Bank and Trade References (only needed for customers located in US) can be provided by Customers in their own documents or be filled out in our Credit 
Application form (section Raw Material Trade Supplier references and Bank information). 

NOTE! If payment terms are cash in advance or for US Governmental Institutions or non-trade customers, Bank and Trade references is not required!

https://lh3.googleusercontent.com/uVSVZdMG2Z-8MUNvdhOocGswOacgnWgIuycuQW0TAGYDNaCvY9I3J-aV_JI5S1cotYB8s9WsneqGIJ_I5aFYrb_MYbsQeVPmxsAZLa7YV99ds47Pi8vUWemRdxakMRgDajlp9qk
https://lh5.googleusercontent.com/n0tyH4c6dwbbG_9x-uUN5LEXPd-hHA6G4FF5enw4XRoFQX6syzK0gqTR6X4FbQRTH1E0b3wapwed2oXXqUjq09gtmOosewlPEi0smQnFYURPvGRlyjwNyN3MHnhVBx__rcW5spU
https://lh6.googleusercontent.com/w-qMUUgtxZwbSGZSKFnotZKdWzfT918FsqgCqjaPTeUjGXgfQo6oFW-ZDqWAoRT7A7ClSCN2o25Clmlsn5ImUm9-Zu68EWxiAOGNIGYZfsql2D_VJP93HxI9NZBoOd5X7Qu-RAA
https://lh5.googleusercontent.com/DaoCHTz36Ug4Ii9fV--N63w1gHfoOv9uzAXxD7buWk2JGCY0qU-HDsy8-JN9kPVRFkyqZeRbw7qs2XWJiMKRPbEvNf-w1SUt_xFtV3O10CwexqcZOkzAiGL0K1leYEQEkwExS3c
https://lh5.googleusercontent.com/iMHqAJICZMkrMZ_v7NVGoafTf_S2RjCPFt0ZxkVYeS5wXVkjsyV3tipIGD30dYwtRHpL-BEFeO6U9ArA_dDvbY25l8-yDyC0Roj0ofy6hn_n-TwaWXRbWakC_oCdY2BO6olHdKo
https://lh4.googleusercontent.com/uubq8rcJozNnTxmiw1OcTgSqyEQiG7giyQkv9VLKbDE8_57t9ZsL4NZhJ2agh5mmM3bsWTt7K9pwnpcWiXwQKcpH_Lf1QQO4JziPjYzerSx98a1EHVDHbtdY_rggPigJkZBkVgo
https://lh3.googleusercontent.com/scTt0XYYPOzH_RAxbAtfKozq_RAYO_OXFDiYebtqfxdYDTZBl5mTu6TZaVsGfn-YO7h1c8ib7TEGDWdQMgkFs_70WN_w-RY4w_yR4RhVsISlMJeMMaTq0Cvnj4VxNQgXZlB_aPE
https://drive.google.com/open?id=0Bz1L-UDgm5MEU3BycW83UDFNVm8
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1.  

2. Copy of the Purchase Order (or an alternative document)

The correct terms must be stated on the PO (final terms to be determined by Cytec Credit Department) 
The Buyer’s name & phone #

If PO is not yet available (BP has been only quoted, sample orders etc.), letterhead from BP will be enough. 

4. Tax ID certificate when:

Customer is located in China
Customer is set up for Co: 775
Currency is CNY. 

blocked URL

NOTE! For UPDATING or CHANGING THE BP ADDRESS INFORMATION only a Copy of the Purchase Order need to be provided (letterhead or e-mail from
customer also can be accepted). For name changes Official letter is required. See Appendix 3 - Changes/Approvals table for more details. 

All the documentation for both new creations and changes should always be forwarded to Credit Control if their approval/advice is required. 

Checking if a BP already exists

Before creating a new BP in BAAN we need to make sure that this BP does not already exist in BAAN.

In order to do that, follow the steps below.

6.1. Checking if an address already exists

The first verification is that the Address does not exist.  If it does, we will need to check if the BP exists in BAAN.

To verify that an Address exists or to create one, follow the steps below.

Go to DMO Role Menu  Business Partner Main Suppliers  Addresses

blocked URL

When the Addresses screen comes up, go to View  Sort by  Country, ZIP/Postal Code, Address Code

blocked URL

Once the data has been sorted accordingly, click on the blocked URL . Enter the Country and the ZIP Code/Postal Code of the address of the BP we are 
interested in, remove any data from the ‘Address Code’ field and click ‘OK’.

When the search results come up, check if the CUS address in question appears. If it does, do not re-enter.  That would create a duplicate. If it doesn’t the address 
code needs to be created.

If the address exists make a note of the Address Code since we will need to check that a BP exists with that Address Code.  The fact that the Address Code exists 
does not necessarily mean that the BP exists (to create a new CUS address follow the steps described in Chapter 7.1). To check if the BP exists with the address 
we have found (if we have found one), follow the steps below.

In the DMO Role Menu -> Business Partner Maint Suppliers -> Business Partners click on View  Sort by  Address, Business Partner:

blocked URL

Click on theblocked URL. In the pop-up menu that follows enter the Address Code we found when searching addresses (if the Customer is a Chinese Customer 
the Address Code will start with CHC instead of CUS).

Click OK.

If no BP comes up with that Address Code, it means that the BP does not exist and needs to be created.

6.2. Checking if a BP already exists with a different address

Even if you couldn’t find a BP with a correct address in the system, you should also check if the BP itself exists with some other address. Otherwise you could 
potentially create duplicate BP’s in the system with different addresses.

In order to perform this check, go to DMO Role Menu -> Business Partner Main Suppliers -> Business Partners and click on View  Sort by  Search Key, Business 
Partner. Click on the blocked URL and in the pop-up menu that follows enter the name of the requested customer in the ‘Search Key’ field (and clear everything 
from the ‘Business Partner’ field):

blocked URL

Click OK.

If the BP with the same name comes up, check with CSR if they can use this one, or if the address codes should be amended/new BP should be created.

If no BP comes up, then we know for sure that it needs to be created.

https://lh6.googleusercontent.com/1I1TfSEk9pubw0PDNa1xU_0G6fcKAo5q5UsQuroA_HKXNyLXJxw-NGSqncxZ3IknBdkezy9MBYYfiZ5o21Eih3_RimQiaWmOi6Mxr8iLiL8BHh0LNrBAJoS7sg5eR7xsaxdHSAc
https://docs.google.com/document/d/1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY/edit#heading=h.3fwokq0
https://lh5.googleusercontent.com/eEczKaZvGphKjkDT2yQpTLs6ycJlU3jy1N3MpUt8MX0Jw-aRgBZdAzWFD36aa3JKSSxPhEGm3apxnvyynLGJNeZOsGAQrzDKxZrJWjTdTqgOmuPSfj8AtXY3g9q7_GdsJlZpd28
https://lh4.googleusercontent.com/xZCkd5rTijf0zujKergvoKugrxd1LOOY-zR3SbL1eOrLC2TrJ9JdH78OFds-KdFkbkARq8ENyw_6hwN3qfvI2hJ6H2zXKO6AopjhKxU2ZkRSKR9o_tpchexE7_7VrRMqbUM1rqs
https://lh6.googleusercontent.com/5btAZIZj0HwHH-OBO9InndzNgtUQDzxUZZkt1OQ2NYYv-3CQVWRjkqz9C77bF2AyASt5ODkNgyu6MoZL-7bgC802qiAWDCAXiDsgAbZeG7Yd2x5Loon7ASzK1gtgc5MaihQuB10
https://lh4.googleusercontent.com/yxZXj7VASOvadDfnGM1p6NXzWfjnm0P0-dLW-pj1qwh_xNeJ-PGaSeRuIFe6fqI9nKK--1e-HwCQyFuXY9JiXq25781Yj01T998S0z4C0vyNWTDBcB3vCUpVrbOrxzF29UiuCX4
https://lh6.googleusercontent.com/5btAZIZj0HwHH-OBO9InndzNgtUQDzxUZZkt1OQ2NYYv-3CQVWRjkqz9C77bF2AyASt5ODkNgyu6MoZL-7bgC802qiAWDCAXiDsgAbZeG7Yd2x5Loon7ASzK1gtgc5MaihQuB10
https://lh6.googleusercontent.com/5btAZIZj0HwHH-OBO9InndzNgtUQDzxUZZkt1OQ2NYYv-3CQVWRjkqz9C77bF2AyASt5ODkNgyu6MoZL-7bgC802qiAWDCAXiDsgAbZeG7Yd2x5Loon7ASzK1gtgc5MaihQuB10
https://lh5.googleusercontent.com/mbHd2EWYil_JMQoS1t_S8HaGSary5I_1WGF3z5MAzLdHQxvS9ZLcExG3r6x_QaWNoavAhogPTz8ysX7fWJHRWL1yaYIA1y2-LiSb3tC_8c3XTaMkDBvtJ6GVaSQ8Bu_-_DWrWfo
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1.  Creating a Business Partner – Customer

If the BP doesn’t already exist in the system, it needs to be created.

7.1 Creating a Business Partner

In the DMO Role Menu -> Business Partner Maint Suppliers -> Business Partners click onblocked URL. This will open a pop-up window, where you need to 
complete the following tabs and fields in them.

7.1.1 Creating a business partner – General

Business Partner: 

500 for customers
805 for Chinese customers
Baan will automatically assign a new business partner number (you should only enter the first three digits as indicated above, and the full number will be 
generated after saving the record)

Name:

The name of the business partner as it appears in the request.

CAPITALS

Search Key:

This field is automatically completed, based on the name of the partner. Check however the interpretation of the system as it doesn’t transfer correctly if any 
punctuation symbols are included in the name.

CAPITALS

NOTE! For Intercompanies should be CEM or CYT/Infinium Co #/ location or name of BP (see Appendix 8 for more details).

Parent B. Partner:

If the BP being entered is associated with a parent BP enter the number of that BP here (the BP Parent can be searched by clicking on theblocked URL icon on the 
field)

Address:

Check if the address already exists by selecting blocked URL next to the address; in the next pop-up window click on the ‘Sort by…’ and select ‘Search Key, 
Address Code’:

blocked URL

Click on blocked URL.

In the pop-up window, make sure that the field Adress Code is empty,enter the search key (address name – company name of the vendor) and hit ‘OK’.

blocked URL

The closest match to your search will be on the first line of the next screen:

blocked URL

To check further details of the addresses, select the line, click onblocked URL and run through the screens by hitting the tabsblocked URL.

If everything has been verified close the address. If the address is correct select the chosen address code by double clicking on the line. The address number will 
be copied to the first screen:

blocked URL

If the address doesn’t exist, it needs to be created (please see chapter 7.2 – Creating an address).

Contact:

CUS028382 collections Riga contact - should be added as the invoice receiver for all new customer accounts, exception -co:775 - contact to be used: 
CHX000499  Please follow the steps in Appendix 10. should be added as the invoice receiver for all new customer accounts. Please follow the steps in Appendix 
10.

Note! You will not be able to checkmark “Invoice-to B. Partner” until “Invoice-to” role is activated by the credit manager. 

If requested by Credit management,  CASH APP RIGA contact  CUS021140 should be added and activated for invoice-to role as well. 

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

 ‘From’ field 1:

The creation date (format – MMDDYYYY)

https://lh6.googleusercontent.com/DUWdHfVxldNTpfV1G5-X8toKz5s9JT5MUhPl-bXEStu1p8G3A3U3TZXp2mRhc2wPALhP4cdkM73WiGmMUe2wqkcyzPEgZooNdBQgTV-4PzW8cEWkOnH20ky2MweXCde6WKV8lV4
https://lh4.googleusercontent.com/UKDKMVX23M2v2j2pAon0S0PYoHj4evwmFBtt3oHfXkNI0fKy4oLNCCdP3HTBJxTlWffYUkDDJeg49_GsoGnOoQLW0XP3EdeW5eqPxX7I0FIwwIeW4HqmzhYHxY91pGJzbH0nYLY
https://lh3.googleusercontent.com/IKWU2a8wYnSqTrMzM_CwXoPwGsWuVE1t2nbzaxpwhHRHhSNntaNndCYNphNGVak7MH9WNZaN0DI8x6zkZxyp6tAnpJjh-Ju_dJNSVRNkYJd2zIduX8Ggz6qqv-fCBSim_xnE6W8
https://lh6.googleusercontent.com/QUaxDfBsQC_jK_lKtrDxc1Ldx15nbO5mo5o_wDfQcI9vAEh5aHiw5ax-uV05Wfi5SVBW1CCWA-5tTUigtETgnY2VwTZms4AUnLdP6UU6O-3-THCqVfNSrKLNuV8pARWvMQY_QdY
https://lh3.googleusercontent.com/tBq0VAcVU4sn_C9-7Hp_EcgZLo5N_hpy6ekqSI-7-8lZq-xmFaYDerpSbEOHb68F3NwvcksVduEKdzNFmPio64lFEZ2bI015yPyssKlzbd93EpydrJSbLwh4ZR9pPdiIXm0htIo
https://lh6.googleusercontent.com/q3iRFRbRGIfGxnoJ40uv0A0z7EUtg6PgiqIR55ScwMEh3ywEVun2AmVlX-XJIyx9eISmaXcv6TLyRSm5CK0GhqUTYCSRDtJ5RwJPQf7rSF3q7iS4d4rwOgPlpE9ULVV6nCo5P4g
https://lh5.googleusercontent.com/Bk7CQg98gGW0NTLEGysDuhRV8m0v4vTDQ4Ymcx01oOd3DxsjvAHz5LY-frPgUq9AqNDiXLp8u1mC1qX9WW8ed6H8ZZxz8TLp5KUCmAbTWpQr_RfLBkDvZ68B27P-rOf_g6eW-6o
https://lh6.googleusercontent.com/CsgPpYjdiK60Ulhu8wZZGZHU1kPnPJV45Wo6awg7sM3rSAZEJ4zJfM4a3Ce_cGC5JP9tkhCb3Os4gYCeSKwZUHXaOiaySfJJ5bRi-Tr68WGucDqAX9Uk-eFl9HBWUzW-ujEiF50
https://lh5.googleusercontent.com/QzcKqGeV32cIXqO7wR9oupb__bvGIZCPep363IuvIWpAjnNauRdP6sAdeDpFK3cTEGMwv3AfOAtzpzDS27FyKN-j90lM9tYkhgUx5HdlleqS7wycJpi-QTN8ew0Fbls27A51dgM
https://lh3.googleusercontent.com/pm8ObQNzDC-m_aWJU9MvC3BZOhA1wlzf30QYB1YEAi63QolUaAhxUMT4S2vD92zlroYMKxPxwwtHTI67-D44mEuMB3O8wCZmifTtvXhn-nEO3rYXJBwDJ246NVzhOWkGzl49mcs
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‘From’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

‘To’ field 1:

Left blank upon creation (only populated when inactivating customers)

‘To’ field 2:

Left blank upon creation

blocked URL

7.1.2 Creating a business partner – Detailed

Language: ENG

Currency:

Company Domestic Export

100 (USA) USD XXX

187 (UK) XXX XXX

775 (China) CNY if specifically requested, if not – XXX* XXX

*for domestic customers in Co: 775 (China), if currency is anything other than CNY always verify it with the requester. If a customer is located in China and the 
currency is CNY, then a tax ID and a document supporting it should be provided as well (these customers are sometimes referred to as ‘golden tax’ customers and 
we should also request a Chinese translation for them to be uploaded into a separate database)

blocked URL

Tax number: Complete with the VAT-number for Europe or a Tax ID number for customers set up in Co: 775, located in China and with currency CNY. For 
Europe, precede the VAT number with the country code (ex.: DE197458191). 

If a tax number is filled in in the address code, this field will be populated automatically from there.

7.1.3 Creating a business partner – Enterprise Modeling

No fields must be completed.  

Click blocked URL and return to the ‘General’ tab.

After the record has been saved, the system will generate the BP code:

blocked URL

7.1.4 Creating Sold-to Extension record

For each new Customer account, Extension Record should be created. It will be used to indicate specific selling characteristics of the Aerospace Customer such 
as segmentation classification, shipping tolerances as they apply to quantities and dates, lead times, etc.  Unfortunately, when this custom session was created 
there was no provision for automatically creating an extension

when the sold-to record was created. 

Step 1. After saving the new Business Partner record in tccom4100s000 click on the ‘Sold-to Extn’ button.

Note: Alternatively, you can click on the ‘Extension’ button in session tccom4110s000 after selecting the ‘Sold-to’ Role.

blocked URL

Step 2. Click on the ‘New’ icon in the tool bar to open session ‘Sold To Business Partner Extension Sub Session’,           tccom9110s00c.

blocked URL

Step 3. (Note that the sub session already contains the new Sold To BP number). 

Enter the code  (NEW has been in use previously) in field highlighted below and select the ‘Save’ then ‘Close’ button. Process completed.‘NW’

https://lh5.googleusercontent.com/Rp2xk_4vbs9LDhnyCs0q2OVb_3GcYHXnFuhFOF3QzRG6Ca7TOY9W5LKp0FTvDmt0QpH_kF-SxKuMBefUx60caK5Dz-djAgD7eWviE3Zs2G1R8brN0lzP6gL-t6CxSlCBoG-DdMM
https://lh5.googleusercontent.com/QlPShdz12ZLR0YlZ3_dvqjOUxnoLGify6zEiOPxOKQK_IRk2QgWo5ZmxcxkuLf2iPvi4D-KHs_1AFUTs04wKhP6gGqA9QynW_-t5cJiFimEzgtastSVZ8AdC94wlrpUIB-fLG1A
https://lh5.googleusercontent.com/CCabxXCc2v-rl-gJXx8j66oZPwwwfuWxHstJILa-iKeRTO_wzF6HSpZa6bArn90onooTBgc4D-cbZnd0wmmJLEFSyPj7hwFawR_1wV-Kjqdc31FweM75MiW-ThDWZBi1-R6UrBw
https://lh3.googleusercontent.com/t8P7yKOoLW5SEBDDfTHc8BeGEwZ0CZmBGHKHFE9sErxLTyAr8cjCK5oav6RZadxCQaveEGUKkuG1UVwYbk2yZOOMZDZF579CFd9SjS_l2MBrE4AGvmrHPnRzzGW90ZmbShEPEoY
https://lh6.googleusercontent.com/wbefmlLuyV5ydB3ODVozgV87OD3vFdjNWYhxkOnEAoyAbnuuvuBwyWTz6QvZQ1ojoQfNVjQ-SenBfzaC4pQL1gNxPu58NIPbMeZpcC7SNyCdTfTjeeWGycEPq8FbocCdbrAcr2w
https://lh4.googleusercontent.com/qJpB3wgirTFgm_QejLx03w-KzJdmxhlvUrRu1ZnoyBlXN6QTNfCIUd_SAXPCdH_THlRUU8wLXa3_CvgGs9MI9Y-_IEfVcahAt6lnERFa285ziMId3B_ywEKtxKyKNgSXQz3sL40
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blocked URL

Once the Business Partner Extension record has been created the Customer Service Group can access the session and add other desired Customer information.

7.2 Creating an address

Select blocked URL next to the address field in the Business Partner (alternatively you can create the address before creating a main BP through the ‘DMO Role 
Menu -> Business Partners Maint Suppliers -> Addresses’ menu).

On the next screen selectblocked URL.

blocked URL

On the next screens complete the fields as follows.

7.2.1 Creating an address – General

Address Code: CUS 

CHC for customers in Co: 775 (mandatory, since an order cannot be created otherwise)

Name: Company name

Longer names can be completed on the tab Address Additions (field Name2)

CAPITALS

NOTE! If customer name changes, but all other info (including VAT, if applicable) remains the same, there is no need to create a new address code – the name 
can be updated in the existing address itself (for all companies)

Search Key: Check the key created by the system and correct if necessary

CAPITALS

Country: Select blocked URL and double click on the required country code

Address: Street and house number (if available)

Longer address can be completed on the tab Address Additions (field ‘Address 2’ and even ‘Name 2’ can be used for longer addresses as well as for “Attention to”)

CAPITALS

House #: blank – not used

P.O. Box #: Used to insert a P.O. Box (if available; number only)

ZIP Code/Postal Code:

To be completed, if available (always populated for Co: 100 and Co: 775; in Co: 187 populated only for customers located in UK– for all the rest postal code is 
filled in before the city in the ‘City’ field – see screen shot below)

Dashes are allowed

City: To be completed

GEO Code: To be completed for the US

First 5 digits of the ZIP-code

State/Province: To be completed for the US & Canada

Select blocked URL and choose the correct value from the pop-up

blocked URL

Remark: When creating addresses leave punctuation out (dots, commas, dashes, etc.) – except for postal codes (these can be entered in their original format – 
with dashes).

7.2.2 Creating an address – Detailed

Telephone: if available; without the country code as this is already given by the system (under CUS or CHC)

Formats –

For US and Canada: XXX XXX XXXX

Rest of the World: XXXXXXXXXX 

Fax: if available; without the country code as this is already given by the system (under CUS or CHC)

Formats –

https://lh5.googleusercontent.com/gEjIhT83nEIxUPNAMK7GaXh_uCvLxuAXGZXX3qFiLsVwClknSfZyccM5yfSBeDG_E4OnTjLUvvqYx7PoJuWHwCcxXQSXhgcrdrloX6uQqbpz9FmgcUcdzwUzD4ewKHyw2vLrnGg
https://lh3.googleusercontent.com/IKWU2a8wYnSqTrMzM_CwXoPwGsWuVE1t2nbzaxpwhHRHhSNntaNndCYNphNGVak7MH9WNZaN0DI8x6zkZxyp6tAnpJjh-Ju_dJNSVRNkYJd2zIduX8Ggz6qqv-fCBSim_xnE6W8
https://lh4.googleusercontent.com/Cd6oXNIZQ2mEryLUg33UmyP35RW87yICmDbPpjGW_OfDKJwK3LGM_BkWGeyKP8pRDzqXYDFoU5JgDdd23raSZnk37KtqhNqNT4w2LCzpGBkmpl3AnMvrj6ROLzmQps3m4cbO9Ps
https://lh5.googleusercontent.com/dWx2Oe8Rh0z29iIDBmuTgQABudqHIjWYPicKcv7syHi9Oe1Yiqj8IG6v7vs0AQnf8QRA4Ri7SaSKHaMAQeRc88IUk7HBc8VyaapDFpq3EBqB-GENyb0E7MSHeAppYlcYT83I940
https://lh3.googleusercontent.com/IKWU2a8wYnSqTrMzM_CwXoPwGsWuVE1t2nbzaxpwhHRHhSNntaNndCYNphNGVak7MH9WNZaN0DI8x6zkZxyp6tAnpJjh-Ju_dJNSVRNkYJd2zIduX8Ggz6qqv-fCBSim_xnE6W8
https://lh3.googleusercontent.com/IKWU2a8wYnSqTrMzM_CwXoPwGsWuVE1t2nbzaxpwhHRHhSNntaNndCYNphNGVak7MH9WNZaN0DI8x6zkZxyp6tAnpJjh-Ju_dJNSVRNkYJd2zIduX8Ggz6qqv-fCBSim_xnE6W8
https://lh4.googleusercontent.com/fhimclJ24gOjlQKrEGw6Rrzx-4yK3Ow7a9q97Yn3CaymC4EUONz9Rg_KofMLNYQF3MLiM5qGwuSgrOIoUbSxX8VzppNiV5y0RvR3xFu88qAWe2puvblsJ70ND3K71N_mlb5NK0E
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For US and Canada: XXX XXX XXXX

Rest of the World: XXXXXXXXXX 

Internet: if available; home page of the company

Tax Number: Complete with the VAT-number for Europe (VATs are not mandatory for customers located in UK – if it is provided, insert this data, but no need to go 
back to the requester if it’s not provided) or a Tax ID number for customers set up in Co: 775, located in China and with currency CNY. 

For Europe, precede the VAT number with the country code (ex.: DE197458191). 

If populated in the address, a tax number will automatically be defaulted in the BP when the address is selected).

blocked URL

7.2.3 Creating an address – Address Additions

This tab is used if the name/address details don’t fit in the General tab. 

Name 2: Used if the Company name does not fit (can be also used for Attention to);

Address 2: Used to insert additional address information (e.g. suite); 

City 2: Used to insert additional city details.

All other fields are not used and must stay blank.

blocked URL

When done, clickblocked URL and blocked URL.

7.3 Partner Roles

We now need to enter the information for the different Roles:

Sold-to 
Ship-to 
Invoice-to (NOTE! DMO has Read-only access to this role and its’ setup and maintenance is handled by the Credit Control)
Pay-by

Note: Not all customers need information to be entered in ALL of these Roles.  If an entry represents a location where we ship to, only the ‘Ship-to’ role will need to 
be populated. In this case, we will also need to have a ‘Sold-to’ number for this ship-to entered in the Parent B. Partner field (see Chapter 8 for more details).

blocked URL

7.3.1 Partner role – Sold-to

‘General’ tab

In the General Tab of the Sold-to role, the following must be completed:

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating roles)

‘Start Date’ field 1:

The creation date (format – MMDDYYYY)

‘Start Date’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

‘End Date’ field 1:

Left blank upon creation (only populated when inactivating roles)

‘End Date’ field 2:

Left blank upon creation

Language: ENG

Area: For customers located in US enter DOM 

For customers located anywhere else leave blank

Address: the customer sold-to address code (usually the same code that is used on the main BP level)

https://lh3.googleusercontent.com/72EdgyVIRnHha3CCRb4qqerEJEYwk6xclDmmsdjIYoJv6hqONnpPYP8f5CLKg0Hvgj8dRm9SB2cgGvMCy9_VBpoU6C5kOuWhME_QZn-A57H04lLAJFREthbEWX-VJLbIXDuixwQ
https://lh6.googleusercontent.com/DEcXJRrN9D8RPEnQ5cRbQXxn3B9CSeVo8q0c4D5Vtzc6Nm0uNqjn4zvGko_e6a01AQecVjeP23M3tC3n3SiO4oOM2dzFMmTJvCJMm_uz1BIwZ9o23Cy0K7E14zaUD4S74csmGjw
https://lh5.googleusercontent.com/CCabxXCc2v-rl-gJXx8j66oZPwwwfuWxHstJILa-iKeRTO_wzF6HSpZa6bArn90onooTBgc4D-cbZnd0wmmJLEFSyPj7hwFawR_1wV-Kjqdc31FweM75MiW-ThDWZBi1-R6UrBw
https://lh5.googleusercontent.com/jtDVfiJr4TTnenF8GgrLb0V_DvqXfJKT67XA_PnLr4zzHjqfUlIW7TS9uFBuhMhL40Z5Z_nCX_hZ7JhlIxf0-s_cV6Vx3U0vPkhKjl2CcW5MVB7Jw1i2qOZZ0vLB8iNDqkB4cck
https://lh6.googleusercontent.com/7XlbHAcpHcxLsdx1p2CGMDP60BHirnRlI4lw1uclHy5C8tAUvgScjmMF2SbrdurS9KZKcS4lAhFNazE7MGcpiCIZOUAAxIc0iTRx8qoJf-uyVE1HBdUjs1b-4pL0HDIPfWZ9Ot8


Page 9 of 23

This document is the property of Solvay. Any reproduction or communication to third parties is only possible with the company’s authorization. This 
printed document may be out of date. Please check the latest version on the Intranet.

blocked URL

‘Pricing’ tab

B.P. Pr. / Disc.: For customers located in US enter DOM (in the second field; if populated on the previous tab – in the field ‘Area’ - should populate here 
automatically)

For customers located anywhere else leave blank

blocked URL

‘Selling’ tab

Sales Order Type:

Company Domestic Export

100 (USA) STD EXP

187 (UK) blank blank

775 (China) blank EXP

Channel: select the country where goods are going to be shipped

EDI Chg. Res.: select ‘Not Applicable’ from the drop-down list

blocked URL

‘Shipping’ tab

Terms of Delivery: select ‘1’ (for FOB Sell Plant, Frt Collect) for Co: 100 and Co: 775

Select ‘10’ for Co: 187

blocked URL

‘Invoicing’ tab

No fields must be completed.  

blocked URL

Click blocked URL and the role will be saved.

That will bring us back to the Business Partner screen.

7.3.2 Partner role – Ship-to

‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating roles)

‘From’ field 1:

The creation date (format – MMDDYYYY)

‘From’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

‘To’ field 1:

Left blank upon creation (only populated when inactivating roles)

‘To’ field 2:

Left blank upon creation

Language: ENG

Address: if the Ship-to address/name is different from the Sold-to address/name, create the correct second address and input it here (if they are the same, then the 
address codes in this role, the Sold-to role and the main BP should also be the same)

blocked URL

https://lh3.googleusercontent.com/paV3ry5vJpDc2jrxBEz0VkmbqlUpqEPqyAWbe_OGqikAKgm6YaNFARvB7VPPl_kpv5CiCgWpx8C0pNiVQO5bjAWjwWNZkhnjsV28xFEjaOv_J352VtYU6zhua_htbH8Xd5vZ1f8
https://lh5.googleusercontent.com/ML7CxzRS_u_0BXk_mScNAH8kuew4sQgRZN_Oldvo9KOQJwj4hZQiv-p7OCRlLmi-F32SLruYbSmUs6MEjZec5Y3UgVkvPrPjyIw9DxTnCDKgfS8_jR_AQnzxQEPIUu7zZo_k_NY
https://lh5.googleusercontent.com/QGVDAOq-kyLaeOixwvMT9OxkUd4m8Gs_6AvmiqxwuGn2vLZu5SzfU_-DWgLImX1SKhrjmVeRclvhT-bg8Ex-DMvFeSGsuEp6X6-NkkPTlnsot3jhQCowl8mGAQ4ySCwZtwpCBdc
https://lh4.googleusercontent.com/p0fw5842YxmFHoL9aIZ2twuZtYJ-V6ecGGGkteu6gqQ2BpHUar7P1Ogoem4SZOvtirc5vDzi_hRZzhKYVvXUNDYAPpDKaQoAjNii8DX8jEvZ269gKZMynnkPXj2gMBW07rcifX8
https://lh6.googleusercontent.com/0c-7BkMDVmt41azOIpWrpZQxUg0VQ4H9cx8iHxqrzOi9Qg7jhupJFtwfBTMUr74pBSSy649qapgEknRFBWl55LD8WomXtuGg7oi-dTlZnHYZko7GD3yW3f-sHNwIaSZrEz_W7b8
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh6.googleusercontent.com/43fGwvdi85DEqwoK2VbMew0RY8zHpTyvZsSHlaAP7-49Qsjv1yfw5UJ3gFSmmqqz-94C6Z4NYutEzaHh4Z8L1l33xEXsUrsM-8j5qbaOvINH1kkYlHZy7pi3TIT2aRTc8MlqlDQ
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‘Selling’ tab

No fields need to be populated.

Sold-to B. Partner: do not populate, even if we’re creating simply a new ship-to BP (see Chapter 8 for more details on how to create a new ship-to)

blocked URL

‘Shipping’ tab

No fields should be populated.

blocked URL

Click blocked URL and the role will be saved.

That will bring us back to the Business Partner screen.

NOTE! For all Boeing customers a special text should be added to the ship-to role (this text should not be inserted on the main BP level – only in the Ship-to role!) 
in the following format:

~SELLER HEREBY ACKNOWLEDGES THAT THE PARTS AND/OR MATERIALS BEING SHIPPED UNDER 

~THIS ORDER ARE INTENDED FOR USE UNDER BOEING’S FEDERAL AVIATION ADMINISTRATION 

~(FAA) ISSUED PRODUCTION CERTIFICATE 700

Please don’t omit any special symbols (including the tilde sign ~ which will enable system to print this text on the documents) – the text should be inserted exactly 
as it is shown above. 

7.3.3 Partner role – Invoice-to

DMO has Read-only access to this role. It is maintained by the Credit Control representatives!

7.3.4 Partner role – Pay-by

‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating roles)

‘From’ field 1:

The creation date (format – MMDDYYYY)

‘From’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

‘To’ field 1:

Left blank upon creation (only populated when inactivating roles)

‘To’ field 2:

Left blank upon creation

Language: ENG

Address: a corresponding Address Code (usually should be the same as in the main BP and the ‘Sold-to’ role, in rare exceptions can be different as specified; Addr
ess codes in ‘Pay-By’ and ‘Invoice-to’ roles should always be the same!)

blocked URL

‘Paying’ tab

Currency:

Company Domestic Export

100 (USA) USD XXX

187 (UK) XXX XXX

775 (China) CNY if specifically requested, if not – XXX* XXX

https://lh5.googleusercontent.com/hv_RSlHXc7x8g0BVHimWkBLNPZYoqOSATRvYtwlBrPBrpMxpRmgaXcz-H0C1A4ua04k3ge4ED4BtrGw0n31elU1XspeufYnl8zEsgPdluBmk6KiIA58AAm5EzLN_p-rS-Nfb96Q
https://lh4.googleusercontent.com/RBHic36F1fmzbQ3a9hpUfgWrAl52zTt-XDXgK4c7P4sN5Japy5rE3zGXhf1EEzTex_lX_RlzyaYD8hFESLdlvHYvASnf-iKRhVRk8u9bvGOI5nBGfSVTMtlZSri4-rMFJKvkgF4
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh6.googleusercontent.com/ggwIMcYhU17HbKVldnaxb7xwF6Ey69IKXstTfrqFKs5BVzkk4itfidUgWArpWVOpfGnqz2jUVGjLIgBe9qdnwn_e2H162fY3L2cgEZwkDtXSsnL37iowMgEXROIzAaYrMfTPiaw


Page 11 of 23

This document is the property of Solvay. Any reproduction or communication to third parties is only possible with the company’s authorization. This 
printed document may be out of date. Please check the latest version on the Intranet.

*for domestic customers in Co: 775 (China), if currency is anything other than CNY always verify it with the requester. If a customer is located in China and the 
currency is CNY, then a tax ID and a document supporting it should be provided as well (these customers are sometimes referred to as ‘golden tax’ customers and 
we should also request a Chinese translation for them to be uploaded into a separate database)

If the ‘Currency’ field was populated earlier (on the main BP level, tab ‘Detailed’) it will be populated here automatically.

Exchange Rate Type: DFT

Bank: if bank details are provided for domestic customers in Co: 775 (China), the banking information should be set up –please see Appendix 9 for more details)

Remit-to Address:

Company Domestic Export

100 (USA) BNK000003 BNK000005

187 (UK) blank blank

775 (China) CHB000006 blank

blocked URL

NOTE! If banking information is provided in the request (most commonly for US and Canadian customers), it has to be added as well. If it’s not provided, there is 
no need to go back to the requester.

In order to do this, first of all click on the ‘Bank’:

blocked URL

In the appearing window select ‘New’:

blocked URL

And in the next step add a new banking transaction - populate all the fields as follows:

blocked URL

Bank: FUB

Bank Type: Bank

Account Type: Normal Account

Bank Account: type in the bank account provided in the request

Important! Bank account must be preceded with zeroes so that it is 13 characters long in total.

NOTE! It is not possible to add multiple transaction codes (FUB1, FUB2, etc…) for customers in BAAN – unlike for vendors. If bank info is already in place in the 
system, but it is different from the info provided, you will need to override the existing data in the same ‘FUB’ transaction.

Next we need to either find or (most likely) create a new bank used by the customer. In order to do this, click on the ‘Address Code’ (selected on the screen shot 
above) and in the appearing window click on ‘Search’ to check if the bank address code already exists in Baan (search by part of the name). All customer banks 
should begin with ‘BKC’.

blocked URL

If a bank under the same name already exists, it does not necessarily mean that we can use it. Please open the bank (click on ‘Open Read-Only’) and check the
last tab (‘Address Additions’) of a bank code.

The part that we are interested is the ‘Bank ID’ field. If a correct ABA routing number is populated in this field, we can use this bank code. If this field is empty or
doesn’t match the provided bank ID, you should create a new bank code.

If the bank exists, click on the correct line (selecting the matching bank), click ‘OK’ and you’ll return to the customer banking transaction screen. 

If the bank does not exist, set it up – exactly as the normal address code with a few exceptions – please complete the fields as follows:

‘General’ tab

blocked URL

Address Code: BKC

Name: type in the bank name provided

Search Key: will populate automatically based on the ‘Name’ value

https://lh6.googleusercontent.com/d7_apERVAsxB0iMYIYYG5yFljFv7bWgwgB8YJcH6kN_9rDCIhnX1IphSiuQtrJOEEAmfj2luCDZ7NyK7hxvAunM8Fd7aG8hAc_54NztMS8eta6TwHMkMUxkYpFxgXrGRqxrJuFI
https://lh3.googleusercontent.com/GYgmCJhjXPRTkqO6Y0C3_nAFSKdIH8jYuEDLtysWzYG6GjRukfeseIChWMj6TfU9AF6mX5K0RRpyI7NMKKrUA7_OwcbPo-ZUYBO-LRcJ2ObNd2JxPx7YZa7rZmXqLz1xQ-6F6aI
https://lh6.googleusercontent.com/mLyM5AMxwJAr4KLNaJyNvd5Mq6nZ-T6wyNHjLcW0wQvhIkWUiv9jY7DSVr6rWAl2A_afIr81jYzx95Xzn_fLZJvlIs2mrubh3ngZUFtmmtCRfHF0238J_3Wr2JyUrOqrWuHNLgg
https://lh3.googleusercontent.com/XHxTQmO8Og7r5gGOV9zapfAW0eG9__qQOgJn9hyctzyL3iMripA99MJ_FykiOXrSSf8i1yrVUNsNAc9CFdYq4oh4S6RHQ9XXJtTf3oPv4tzmvPyWWPWgJ9k4GTq5HcWxmt4Nbu8
https://lh3.googleusercontent.com/WQWYFihlmd2w81du5CjIoY2DBYxxeEn7ZzH6r60IJemSEOH83fhzvMDU9zHpOl6ugruMs72VRANgqdea0hR8wYz_L7EY4N-3fOdINom8RxKxvbPXCOYwoOIvPQXAEYUQ1zfyYTs
https://lh4.googleusercontent.com/NHNQMkvWVPdPq5RRkGtvIquWo92245lS-RTnjOZItAlSNPgv-zcijq9NmQP0Z95zmu_i1_-Y7yiJC_rK-UFCVF17Ug7EtoYwyqDlMgjY0b1G1Ceo86oLQvd7B0T06phnS1FWGp8
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1.  

The rest of the fields should be left blank.

‘Detailed’ tab

All the fields should be left blank.

‘Address Additions’ tab

blocked URL

SWIFT code: add a SWIFT code if the customer bank address is in Europe

Bank ID: add the routing number (ABA) if the customer bank address is in US/CA

Important! The routing number is mandatory information for US/CA – if it’s not provided, do not populate banking information for the customer. The routing number 
should also be verified beforehand. In order to do that, please go to Validations for Customer and Vendor Master Data.  and follow the instructions provided on the 
screen. The validation should be saved in a pdf format and attached to the ticket.

The rest of the fields should be left blank.

Clickblocked URL. A new bank code has been successfully created and will appear in the bank list window which you will be automatically forwarded to. Click on
the correct line (selecting the created bank), click ‘OK’ and you’ll return to the customer banking transaction screen:

blocked URL

Click ‘Save’ and ‘Close’ and you will be returned to the ‘Banks by Pay-By Business Partner’ screen. Click ‘OK’ but do not select the transaction created! It should 
be available in this drop-down, however it should not appear in the customer master ‘Bank’ field – please verify that it’s blank:

blocked URL

Click blocked URL and the role will be saved.

That will bring us back to the Business Partner screen.

Clickblocked URL. 

As a last step in BP creation, we should add a text explaining what we have done, who requested it and who approved it. In order to do that, in the BP ‘General’ 
tab, click on the blocked URL icon.

The following window will appear:

blocked URL

Choose ‘Create’ and it the next pop-up window put the text in the following format:

blocked URL

NOTE! Please don’t use the tilde symbol (~) when adding texts in BAAN. This symbol prompts the system to print the text on the documents (if requested 
specifically; normally the text don’t get printed on the invoices).

Click blocked URL and close the window. Clickblocked URL.

The BP setup is now complete. 

Send an e-mail to Credit Control asking them to approve the created customer and complete the ‘Invoice-To role (put the original requester in ‘CC’), and after this 
is done and the reply from the Credit rep is received, close the ticket.

 Creating a new Ship-to

When you receive a request to create a new Ship-to for a certain Sold-to that already exists, you have to do the following.

Firstly, create a new main BP as described in the section 7.2 – 7.2.3 of this document.

NOTE! In the main BP ‘General’ screen “Parent B. Partner” field put the corresponding ‘Sold-to’ number, like this (you can’t link an existing , even if it is inactive, 
Ship-to to other Sold-to’s in the future – it will mess up the statistics for audits, so it is not allowed to change this number; removing this number is also not advised 
– even if the default settings are requested to be amended - since this can impact another locations):

blocked URL

When a main BP is created, the only role that needs to be filled in is the ‘Ship-to’ role.

‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

‘From’ field 1:

The creation date (format – MMDDYYYY)

‘From’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

‘To’ field 1:

Left blank upon creation (only populated when inactivating customers)

https://lh4.googleusercontent.com/q1ocZ6htrt-C0nzxvTK7mTqckmTT5A2dCTrIwXw_NY0_E5Hdu-Vlbd47v0G-9DF-OSsUgdekAmw3UmbbZMcGogiGINo3QqdhHkspfEiKDS8T_7TjgF3GAfehvpyKjhRDrO5efZY
https://wiki.syensqo.com/display/DO/Validations+For+Customer+And+Vendor+Master+Data
https://lh5.googleusercontent.com/CCabxXCc2v-rl-gJXx8j66oZPwwwfuWxHstJILa-iKeRTO_wzF6HSpZa6bArn90onooTBgc4D-cbZnd0wmmJLEFSyPj7hwFawR_1wV-Kjqdc31FweM75MiW-ThDWZBi1-R6UrBw
https://lh6.googleusercontent.com/qDRbDTGk7l9t7IX-Zd_H3HViGkspGtQ6ocpqtke4v3YTTZhqf44axxj036q6_BgeyCx5rVAJrkWDIxU73mfjfk1H6-r9_rDbwJMrBCWG5rtNo7JOEmqcBqbjlTzg95h590IEjUQ
https://lh4.googleusercontent.com/4AUFWVBymgQrM2tCZVHQFkVBFYHbJ3_Xyxuewat-fEvmRAyjCSPPTZNNcuk7Fzu_qjbNR5MDk0dJ1skXtFPUYE3uav2h_GupG5VNUeHWiy0HtwuciBKb_mhbCOyjOtRzzBd53hI
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh5.googleusercontent.com/CCabxXCc2v-rl-gJXx8j66oZPwwwfuWxHstJILa-iKeRTO_wzF6HSpZa6bArn90onooTBgc4D-cbZnd0wmmJLEFSyPj7hwFawR_1wV-Kjqdc31FweM75MiW-ThDWZBi1-R6UrBw
https://lh6.googleusercontent.com/OFubuQ3cz4vxxqFC6ehCgURtTa8AydYJgz1q7qCRaNBZyQWETuwVW-5eYWzlB-AiEItwNkO2CDOMDAdWY-yEBxmEA_chE6SNqcJlSc0jUwnSJc17d-maMmT1qiLT16Ej-GqeyEo
https://lh5.googleusercontent.com/4eEYyYWG7Mhkq9ySUXmRJ1r4acmQq2Geyh5kDa_KRNX0k32sX7V3AKw6ZidaWIt_T5JEPkbGj_3RF8rrYMpEdzXPjzSoXfhEXqbJ8_yCzzIfifToAWxQXe8eGGUg2WQWyln__pc
https://lh5.googleusercontent.com/0_cnnhpVhMf7iTbYa4D8ZWjslpv6wpGOOhLEboNn57S2BC5LZ9erUGrx8wzwFHr1zrD35BeR7h5YNrUjeh87pW6so5QWQbS0bVBBcLmaQOIMBWoJXUMOT06ZCjtSKI4NtjK2DwE
https://lh6.googleusercontent.com/BffyPwcPOxoRKYtpS40kJmghbi0yyvFnllFfqz0wprGJxbIkwGsh8wiPIyFX4hb43FtOcBgA0bwxvWjAWqYuDHVbaNh1ejZja8yE9PCi8U_XMnNWu7gBnNNaKzo5NcuIFc0B65c
https://lh6.googleusercontent.com/RwJlbkBqmH3xvGMS3MOmtVWmfvEQLatJuiX7eRtK4CK9H20CvIa6928oGL4wPqmm9vEwIELeWQVeCod0hU_s5bHxy2BbLsUf4gZWEUkOXiEfAdQ0LfZj5na30MR4yKS4KUYC_t4
https://lh4.googleusercontent.com/XDEf9Xz8YtAS3KVATMsZIUIkWE_yEm6Vc2T_fLvvNHfJZZ-TNVA7esmfAmRE_g0vGBSjjhT6AiOse2lF980OgtUZKJZNFHauGWB7CwWhRyzF96B_SmJ-NylWTtpC_Lf0aFiCbHE
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1.  

1.  

‘To’ field 2:

Left blank upon creation

Language: ENG

Address: the ship-to address (see Chapter 7.1 for more details on how to create an address)

blocked URL

‘Selling’ tab

No fields need to be populated.

Sold-to B. Partner: do not fill in (should be filled in the main BP ‘Parent B.P.’ field)! 

blocked URL

‘Shipping’ tab

No fields should be populated.

blocked URL

Click blocked URL and the role will be saved.

That will bring us back to the Business Partner screen.

As a last step in ship-to creation, we should add a text explaining what we have done, who requested it and who approved it. In order to do that, in the BP 
‘General’ tab, click on the blocked URL icon.

The following window will appear:

blocked URL

Choose ‘Create’ and it the next pop-up window put the text in the following format:

blocked URL

Click blocked URL and close the window. Clickblocked URL.

The ship-to setup is now complete.

Making changes in the Business Partner

NOTE! Before changing anything in the existing customer, check Appendix 3 (Changes/Approvals table) on whether an approval from Credit Control is needed to 
perform this change. For any changes official documentation should also be included in the request (proof that the change took place).

ALSO! We don’t need to extend BP’s to other Sales organizations (= no accounting departments needed) – a customer BP can be used for any Sales 
Organization. However when making changes you always need to make sure that you are performing these changes in the SO that the customer was created in.

In the Business Partners menu double-click on the Customer we need to change:

blocked URL

When the customer’s main BP screen opens up, chose the Role (Sold-to, Ship-to, or Pay-by) that needs to be updated. Invoice-to role is out of scope for DMO –it 
is handled by the Credit Control.

NOTE! For a name change (if the VAT# stays the same) we can change the name in the CUS address code itself (for all companies)!

Within the Role chose the tab that contains the information that needs to be updated. Click blocked URL when done which will return you to the main BP screen. 

When all the updates have been completed, as a last step, we should add a text explaining what we have done, who requested it and who approved it. In order to 
do that, in the BP ‘General’ tab, click on the blocked URL icon.

The following window will appear:

blocked URL

Choose ‘Create’ and it the next pop-up window put the text in the following format:

blocked URL

Click blocked URL and close the window. Clickblocked URL.

Important! For new domestic US customers and/or ship-to’s please send an e-mail to, informing her about the setup.

Activating customers

In the Business Partners screen, click on theblocked URL. Enter BP # that needs to be activated in the following pop-up window:

blocked URL

Clickblocked URL.

You should see the requested BP # at the top of the list that appears after that:

https://lh6.googleusercontent.com/A4AbbGOQDmbkd7K9KkKYA1M_Ffi9B0mEPqY2jFZ1HApmGqlNon5xlN-33ka0y_tkCFdk8ThUVA7iQP9141D0SaQ9LLkLaZfK-TQ0odO3rdq9nqg56pkbzyiYkw6sJrteKxaNowM
https://lh3.googleusercontent.com/ug-Nh63Kw0ZifJTsBQwg5Wyx4KlWqb3LxaOZeHEPqxcVR5GKC-NsuLdTl6fX-r8h4XLfxiHwqELcbn3JIx7mQRxmzD3yOctXOI01PK9EnWVnGYZTcD0zxW2hdLLcTbUdivH0a4c
https://lh4.googleusercontent.com/RBHic36F1fmzbQ3a9hpUfgWrAl52zTt-XDXgK4c7P4sN5Japy5rE3zGXhf1EEzTex_lX_RlzyaYD8hFESLdlvHYvASnf-iKRhVRk8u9bvGOI5nBGfSVTMtlZSri4-rMFJKvkgF4
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh6.googleusercontent.com/OFubuQ3cz4vxxqFC6ehCgURtTa8AydYJgz1q7qCRaNBZyQWETuwVW-5eYWzlB-AiEItwNkO2CDOMDAdWY-yEBxmEA_chE6SNqcJlSc0jUwnSJc17d-maMmT1qiLT16Ej-GqeyEo
https://lh5.googleusercontent.com/4eEYyYWG7Mhkq9ySUXmRJ1r4acmQq2Geyh5kDa_KRNX0k32sX7V3AKw6ZidaWIt_T5JEPkbGj_3RF8rrYMpEdzXPjzSoXfhEXqbJ8_yCzzIfifToAWxQXe8eGGUg2WQWyln__pc
https://lh5.googleusercontent.com/z7PAo0sDRZv2KqRZXRCjS1HI77-2E2hirfSB2QqCaBMtcNaSiYhAAlksQY1ie6aTWX1WfkW_BQwh18IURvRkG4y0UmdGCE1bUAd-uj1MZrYB6i2SXeDdVTbd8DQtGi1prcvr6KA
https://lh6.googleusercontent.com/BffyPwcPOxoRKYtpS40kJmghbi0yyvFnllFfqz0wprGJxbIkwGsh8wiPIyFX4hb43FtOcBgA0bwxvWjAWqYuDHVbaNh1ejZja8yE9PCi8U_XMnNWu7gBnNNaKzo5NcuIFc0B65c
https://lh6.googleusercontent.com/RwJlbkBqmH3xvGMS3MOmtVWmfvEQLatJuiX7eRtK4CK9H20CvIa6928oGL4wPqmm9vEwIELeWQVeCod0hU_s5bHxy2BbLsUf4gZWEUkOXiEfAdQ0LfZj5na30MR4yKS4KUYC_t4
https://lh3.googleusercontent.com/j6SeEvC49OOa3OS-4ejevVB2CVwhL_YMoNnveK00uYT_kU_PLgaDDBiEVzpUUlUvp-EbR_TDw2jKQKYuvzvp4cWj2rclIOQ2LjLqgpWAJ5E7ifgvqIwNGaSCO1eco_AntC4AsFo
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh6.googleusercontent.com/OFubuQ3cz4vxxqFC6ehCgURtTa8AydYJgz1q7qCRaNBZyQWETuwVW-5eYWzlB-AiEItwNkO2CDOMDAdWY-yEBxmEA_chE6SNqcJlSc0jUwnSJc17d-maMmT1qiLT16Ej-GqeyEo
https://lh5.googleusercontent.com/4eEYyYWG7Mhkq9ySUXmRJ1r4acmQq2Geyh5kDa_KRNX0k32sX7V3AKw6ZidaWIt_T5JEPkbGj_3RF8rrYMpEdzXPjzSoXfhEXqbJ8_yCzzIfifToAWxQXe8eGGUg2WQWyln__pc
https://lh6.googleusercontent.com/9ugFUIbtuEc0e2H6gHXg0UXwBiOZzp9ZYKxGgvQyJsIxcsjX2hiHWuKlFxOUBC3bKrKv3B3TwwBDIGiiAHAWu4Ydd-HrYsLFnwQ6TGfaRyI2wbrIbSzntzNyVddr5lzW0WiaoXc
https://lh6.googleusercontent.com/BffyPwcPOxoRKYtpS40kJmghbi0yyvFnllFfqz0wprGJxbIkwGsh8wiPIyFX4hb43FtOcBgA0bwxvWjAWqYuDHVbaNh1ejZja8yE9PCi8U_XMnNWu7gBnNNaKzo5NcuIFc0B65c
https://lh6.googleusercontent.com/RwJlbkBqmH3xvGMS3MOmtVWmfvEQLatJuiX7eRtK4CK9H20CvIa6928oGL4wPqmm9vEwIELeWQVeCod0hU_s5bHxy2BbLsUf4gZWEUkOXiEfAdQ0LfZj5na30MR4yKS4KUYC_t4
https://lh6.googleusercontent.com/5btAZIZj0HwHH-OBO9InndzNgtUQDzxUZZkt1OQ2NYYv-3CQVWRjkqz9C77bF2AyASt5ODkNgyu6MoZL-7bgC802qiAWDCAXiDsgAbZeG7Yd2x5Loon7ASzK1gtgc5MaihQuB10
https://lh3.googleusercontent.com/qN_1B-Z8Cp6-NmgrktmoNzE1bVX78ZeXRqJniczahYJfFtvilyot9dGtnwQuC6F4giYZiy1O2UzneLFJDg86a6D7bV0TMjknPIANMwADLeQV-NKYKkSds5x1IxVGdq6d9OuEirc
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
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blocked URL

Double-click on the BP.

‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

‘From’ field 1:

The activation date (format – MMDDYYYY)

Important! If you need to activate a BP which was mistakenly inactivated or inactivated too early (before the last orders were processed), please do not enter any 
date here and leave this blank. Otherwise the orders won’t get processed anyway.

‘From’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

‘To’ field 1:

Delete any values if populated (should be left blank)

‘To’ field 2:

Delete any values if populated (should be left blank)

 

blocked URLblocked URL

‘Sold-to’ role – ‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

‘Start Date’ field 1:

The activation date (format – MMDDYYYY)

‘Start Date’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

‘End Date’ field 1:

Delete any values if populated (should be left blank)

‘End Date’ field 2:

Delete any values if populated (should be left blank)

Clickblocked URL.

blocked URLblocked URL

That will return us to the main BP screen.

DMO is not able to make the necessary entries (i.e. set the activation date) in the ‘Invoice-to’ role because we have no access to those screens. Contact the 
responsible Credit Control representative to perform these changes in the ‘Invoice-to’ role.

‘Pay-by’ role – ‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

‘From’ field 1:

The activation date (format – MMDDYYYY)

‘From’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

‘To’ field 1:

Delete any values if populated (should be left blank)

‘To’ field 2:

Delete any values if populated (should be left blank)

Clickblocked URL.

blocked URLblocked URL

https://lh5.googleusercontent.com/2wxLGUfOpMQoadDw3PQ8Bl3GpQlPK8VXcVNqFxEmw7SV_vQXouy83kSlPTwSTduOdxAPAkkqAXTTBlkfInGlaXHNWbzFavFALB7TvlHs-AGi1j0i_38ItnWbOnF_475Yyx47wVo
https://lh5.googleusercontent.com/CWoQMbEs17dSSmFGFe4DU-38QIgN47cQgcjAb8UP2PcaMKfKyKTB6fhDLs7WofQVs7KSpTuaaPg-pVb1AufCM2jgP0ylcbOljv-fLa2j79yTxNONevOXLUIxbzEoyotkZyYnLf0
https://docs.google.com/a/solvay.com/drawings/d/snnd4vIsc2QlzMbxyYyAQ5A/image?w=126&h=27&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh4.googleusercontent.com/9PwSCGdC598EXxgr1dVDXg-iD5g7E-QnwT6A16YgUjBdS1bz8t6szboRsUmPOJdEckYVaa-PDOGGSAexUZH_b5hirAkGqZq-2W-5C7vXWyNOP4t-rwwI0JdJcSU8sFuIXE_Uj_4
https://docs.google.com/a/solvay.com/drawings/d/stF16bvTh9Bp4lXXzjBWI9w/image?w=158&h=28&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh6.googleusercontent.com/2CflOaoV1uZDzZMgF2WxsD1ezx7JItW_iAphQG_fb1l1drDVMAaeNbJQjRFl07wCqjRM_qt8gCYXCKik52SmpN35XU2J1dTgyiQ7fo6wiBQXbULQ1t8WSGA14t-JnkvALHp9o_A
https://docs.google.com/a/solvay.com/drawings/d/sHdnNzB0opxMSAGhxweCrTQ/image?w=147&h=28&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
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1.  

As a last step in customer activation, we should add a text explaining what we have done, who requested it and who approved it. In order to do that, in the BP 
‘General’ tab, click on the blocked URL icon.

The following window will appear:

blocked URL

Choose ‘Create’ and it the next pop-up window put the text in the following format:

blocked URL

Click blocked URL and close the window. Clickblocked URL.

The activation is now complete.

Inactivating Customers

Important! Before you inactivate any customers in the system make sure that that customer is not set as a parent for another Business Partner. This can be done 
through the main Business Partners menu (View -> Filter…):

blocked URL

If there are any Business Partner numbers appearing in the results, please do not inactive your BP. Inform the requester, that this customer is currently set as a 
sold-to to other customers, and if we inactivate it we need to inactivate all of them too.

11.1 Inactivating customers in BAAN

In the Business Partners screen, click on theblocked URL. Enter BP # from the Crystal report in the following pop-up window:

blocked URL

Clickblocked URL.

You should see the requested BP # at the top of the list that appears after that:

blocked URL

Double-click on the BP.

‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

‘From’ field 1:

Leave as it is

‘From’ field 2:

Leave as it is

‘To’ field 1:

The inactivation date (format – MMDDYYYY)

‘To’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

 

ALSO! Unlike for vendors, do not amend the Search Key to ‘INACTIVE’.

blocked URLblocked URL

‘Sold-to’ role – ‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

‘Start Date’’ field 1:

Leave as it is

‘Start Date’’ field 1:

Leave as it is

‘End Date’ field 1:

The inactivation date (format – MMDDYYYY)

https://lh6.googleusercontent.com/OFubuQ3cz4vxxqFC6ehCgURtTa8AydYJgz1q7qCRaNBZyQWETuwVW-5eYWzlB-AiEItwNkO2CDOMDAdWY-yEBxmEA_chE6SNqcJlSc0jUwnSJc17d-maMmT1qiLT16Ej-GqeyEo
https://lh5.googleusercontent.com/4eEYyYWG7Mhkq9ySUXmRJ1r4acmQq2Geyh5kDa_KRNX0k32sX7V3AKw6ZidaWIt_T5JEPkbGj_3RF8rrYMpEdzXPjzSoXfhEXqbJ8_yCzzIfifToAWxQXe8eGGUg2WQWyln__pc
https://lh5.googleusercontent.com/ae1ZJP8Md4nPdWJbOLazUjsk8fae9iMaBe-nkZNYcDYJ9LkNZ0i3xa8G9JFNOGZ288dPPBiJdC7SBnyinkDuYnJC8IPafXDgOj8h_iZqxqAUEGIh_5_E44dvNP_RgNKi6ClCm00
https://lh6.googleusercontent.com/BffyPwcPOxoRKYtpS40kJmghbi0yyvFnllFfqz0wprGJxbIkwGsh8wiPIyFX4hb43FtOcBgA0bwxvWjAWqYuDHVbaNh1ejZja8yE9PCi8U_XMnNWu7gBnNNaKzo5NcuIFc0B65c
https://lh6.googleusercontent.com/RwJlbkBqmH3xvGMS3MOmtVWmfvEQLatJuiX7eRtK4CK9H20CvIa6928oGL4wPqmm9vEwIELeWQVeCod0hU_s5bHxy2BbLsUf4gZWEUkOXiEfAdQ0LfZj5na30MR4yKS4KUYC_t4
https://lh6.googleusercontent.com/bpC_CzakE2Hc3PlqG-9SA5sT-TiWlweNv6VXiTZcdYY_aKY_RkrS7SuI0HsI8T9mOmPmq5DkDGvUWM-0ZNC6N_d3G-41p5PyPF0uGqzbfREWwKQkK0_sS_tTVR_0DvJdEIwkiXU
https://lh6.googleusercontent.com/5btAZIZj0HwHH-OBO9InndzNgtUQDzxUZZkt1OQ2NYYv-3CQVWRjkqz9C77bF2AyASt5ODkNgyu6MoZL-7bgC802qiAWDCAXiDsgAbZeG7Yd2x5Loon7ASzK1gtgc5MaihQuB10
https://lh3.googleusercontent.com/qN_1B-Z8Cp6-NmgrktmoNzE1bVX78ZeXRqJniczahYJfFtvilyot9dGtnwQuC6F4giYZiy1O2UzneLFJDg86a6D7bV0TMjknPIANMwADLeQV-NKYKkSds5x1IxVGdq6d9OuEirc
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh4.googleusercontent.com/77p7eUb5-jqanxD96YveqzLA8inYu_zbmDuKPjtJkIYqAzmPaaVXSVjKfYazNy-FJd4iI4joE6tI6dyBU7AoHpKGVV_651h7S63PUGHiiAmYhOFbLsemCD3lm6KwECQc7WvUnmU
https://lh6.googleusercontent.com/2rF4DxuJTXgv5iSTAMG-a4YIRGUivdabKzQe5WDnH7GlesC4fhn7nCA4APBbKA5ZI62iUGauE9i29pCPdZCNeyrCnq77Psq56vgA2Hb6ZpTl_-EI19hRsZdBvExiCm9PDUH5LYo
https://docs.google.com/a/solvay.com/drawings/d/s_bU7UhCYrn_dmnmUE53NIQ/image?w=121&h=27&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
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‘End Date’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

Clickblocked URL.

blocked URLblocked URL

That will return us to the main BP screen.

DMO is not able to make the necessary entries (i.e. set the inactivation date) in the ‘Invoice-to’ role screens because they have no access to those screens. 
Contact the responsible Credit Control representative to perform these changes in the ‘Invoice-to’ role (see Appendix 5 for more details on what the Credit Control 
reps will have to change in this role).

‘Ship-to’ role – ‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

‘From’ field 1:

Leave as it is

‘From’ field 2:

Leave as it is

‘To’ field 1:

The inactivation date (format – MMDDYYYY)

‘To’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

Clickblocked URL.

blocked URL

‘Pay-by’ role – ‘General’ tab

B. Partner Status:

Should always be left ‘Active’ – a default value (even when inactivating customers)

‘From’ field 1:

Leave as it is

‘From’ field 2:

Leave as it is

‘To’ field 1:

The inactivation date (format – MMDDYYYY)

‘To’ field 2:

Tab through to the next field and this one will be automatically populated with ‘00:00’

Clickblocked URL.

blocked URLblocked URL

As a last step in customer inactivation, we should add a text explaining what we have done, who requested it and who approved it. In order to do that, in the BP 
‘General’ tab, click on the blocked URL icon.

The following window will appear:

blocked URL

Choose ‘Create’ and it the next pop-up window put the text in the following format:

blocked URL

(Two letters in brackets should be initials of the person who performed changes)

Click blocked URL and close the window. Clickblocked URL.

The inactivation is now complete.

Appendix 1 – An example of trade references

https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh6.googleusercontent.com/rwBpdaRy3yo-2gaToZMoI_soHFG8A7q0icMbZMwG26tqhlLiAKWdsKJsRzuTn37Rls6qeQfUlVQCleidw77Qtf6t7af3m9RsJAx3a0-iNPwpprXVL1yd7gDbSSKBbysJCcJ5-wM
https://docs.google.com/a/solvay.com/drawings/d/saLKAloBvLFHkC7CCJ-iztA/image?w=158&h=27&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh5.googleusercontent.com/ID2POItddU19QcNAdj0qVZwU7EB1DxPFzJLpSrigSSkneDCEZukFmcs_3Z6b2dHw7Huky_axCy1y_-UGgEkmM0I9mqVMNfQzvw95_nt8U62e_G52enPggWm6oLJWjercA-wNkSM
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh5.googleusercontent.com/YmKmHlN2aJ4VWl7AyEE6QR04ZYFVkoNmq58lU_lYd7ECv4VpfSYWyYx2idqOJRkugOJGMxjbMAZ8i8zaMKwend0xxTqgN0HaIb1iJoBGTkbvUFRuW2dz8MG4PoWOvePSWA3Mo54
https://docs.google.com/a/solvay.com/drawings/d/sQx5WnwpI6uBKIIHg9EpT4w/image?w=135&h=23&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
https://lh6.googleusercontent.com/OFubuQ3cz4vxxqFC6ehCgURtTa8AydYJgz1q7qCRaNBZyQWETuwVW-5eYWzlB-AiEItwNkO2CDOMDAdWY-yEBxmEA_chE6SNqcJlSc0jUwnSJc17d-maMmT1qiLT16Ej-GqeyEo
https://lh5.googleusercontent.com/4eEYyYWG7Mhkq9ySUXmRJ1r4acmQq2Geyh5kDa_KRNX0k32sX7V3AKw6ZidaWIt_T5JEPkbGj_3RF8rrYMpEdzXPjzSoXfhEXqbJ8_yCzzIfifToAWxQXe8eGGUg2WQWyln__pc
https://lh3.googleusercontent.com/PUAkeR5eojybWTRruJQbJYL2eUErGw1NoVU-Cs1YTvPy8JzibggmBTXURZ8EQ4hIN1KZoZfbZ4WCTiogyODKTLoeTLRrlnN8rqb_UJxS1r1wbRCrIbj-4XJamIcGf9JoJ7WyVus
https://lh6.googleusercontent.com/BffyPwcPOxoRKYtpS40kJmghbi0yyvFnllFfqz0wprGJxbIkwGsh8wiPIyFX4hb43FtOcBgA0bwxvWjAWqYuDHVbaNh1ejZja8yE9PCi8U_XMnNWu7gBnNNaKzo5NcuIFc0B65c
https://lh6.googleusercontent.com/RwJlbkBqmH3xvGMS3MOmtVWmfvEQLatJuiX7eRtK4CK9H20CvIa6928oGL4wPqmm9vEwIELeWQVeCod0hU_s5bHxy2BbLsUf4gZWEUkOXiEfAdQ0LfZj5na30MR4yKS4KUYC_t4
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This is an example of Trade References (supplied by the customer). 

NOTE! As all other information obtained from the customer this is confidential information and has to be submitted to the Credit Control to be kept with the 
Customer file upon creation. 

blocked URLblocked URLblocked URL

Appendix 2 – An example of bank references 

This is an example of Bank References (supplied by the customer). 

NOTE! As all other information obtained from the customer this is confidential information and has to be submitted to the Credit Control to be kept with the 
Customer file upon creation. 

blocked URLblocked URL

Appendix 3 - Changes/Approvals table

TYPE OF CHANGES Credit Approval needed? Responsible for maintenance

Name* YES (can be updated in the address code and in the BP itself, unless – for Europe - the VAT 
number changes as well, then new BP creation)

DMO

Address (within same country or to 
another country)

YES DMO

General telephone # / fax # / URL  NO (can be updated in the address code itself) DMO

Tax ID (VAT…) Create a new BP and add the tax ID / VAT to it, send credit with all docs to complete credit data 
and request inactivation of old record

DMO

Payment terms YES Credit Control in the ‘Invoice-to’ role

Activity status YES DMO and Credit Control (the latter - in 
the ‘Invoice-to’ role)

Ship-to changes NO DMO

* For simple name changes, there is no need to create an entirely new Business Partner – with Credit Control’s approval we can update the existing one. 

If it is an ownership change, though, we have to create a new BP. Therefore, in order to differentiate between the two we have to request a supporting official 
document (an e-mail from the customer will do for US – for Europe a notification can be sent via e-mail, but it has to be an official letter). 

If it is indicated in this document/e-mail that it is a simple name change, send it to Credit Control for their approval (if they still think that we have to create a new 
BP, they will let us know). 

If it’s indicated that there has been a restructuring/merger/acquisition and that’s why the name change, create a new BP and request all documentation for new BP 
creation.

Appendix 4 – A parent Business Partner search

If we click on theblocked URL next to the ‘Partner B. Partner’ field (main BP ‘General’ tab), the ‘Business Partners’ screen below will come up.

blocked URL

Click on blocked URL and the pop-up ‘Filter’ window will appear. Here you can search by the Name ‘between’ two parameters, such as:

blocked URL

Clickblocked URL. 

The list will then show those BPs whose name is within the parameters selected.

blocked URL

You can also sort this list by a specific field – in the second tab in the ‘Filter’ pop-up window select the criteria as desired. For example you can select the following 
criteria:

Name: ‘1’ and ‘Ascending’

Address Code: ‘1’

(See the screen shot below)

blocked URL

Parties in the list will be sorted in ascending order by their name:

https://lh4.googleusercontent.com/Al2eUsZsVQAgVVLk227LiMM3wSO1W1iaf6TfxJOXVGiT2dFD26hkWD6T9-qWTECLH8scdpEwx3epz3-E8Y7U4x3KDTPHZ8VIj13_akbKl0WPZnW4EKpAKjkUh2ngIwa5j5rA5Lo
https://docs.google.com/a/solvay.com/drawings/d/sB8YVWXt9O7PtcrNN04Hilw/image?w=76&h=17&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
https://docs.google.com/a/solvay.com/drawings/d/sVNxwMLWi0EwySaauPTjQzw/image?w=89&h=17&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
https://lh4.googleusercontent.com/iUx5ysbJTFQjxSZnrJ2BXcmoC6OUhA0Y1Z9b5uw5qa1Lz8X73q0hfOxNiwdL-TslC_SUOw3Yr9qF3wYYvvG-4HB6ewsCErbNEMQX8QWZumTD4qC0Ac16-IiAGS34SlK5mAE50bk
https://docs.google.com/a/solvay.com/drawings/d/sYNgKu86_PXq9fkckiQ0UxA/image?w=100&h=25&rev=1&ac=1&parent=1sDFirEcft8jjfR0MxC0lAUBAeabxg5KY
https://lh4.googleusercontent.com/ESeBakO2-CLtKDXnx3xi6Y_omPkO9uZKtG0x7v0rmq3OJ-gVMnyWlGYF0Z7JRj0b-D0sRZ89bAJPpsKyDMjr4S2IGa8IOb13qUwzer0DnHu-4OHd4RqcsXZNgfFg6nJ0pOBOfTk
https://lh6.googleusercontent.com/wyb4Ys0ToMazWpb2fSVdhZCHVeOPrK5ixNNhWLyEpmmWfF15NykNagYZp-PevgMu3gjBdiya8j2OvDsa2umoNqiextLxFCpBZKUpwiF4A0jOwYnx1iGMuIb_QO_PkJwBg5S15bk
https://lh5.googleusercontent.com/GIwJhs4vECtFRrY6l5LiR4n_ajgftyBA3pZxNcefnAyiIHuX6jCs0N1jT6SDogblPODML6gNBgboOlV_m3OCKZ6-MAS40yjlPDHouCbahzeyfLbbEsdaQypuyDjWgV6f1KUItiU
https://lh6.googleusercontent.com/CfWCoQu30NeIpKRMXEXrI14O2blaZrFINHBgc1Nm0o4v-bpqGnvSb6fHwd2uBcxLqP77qiJ6mpJT-NMaW4_ln9CINHcXXV0xK3RwLY7jBW9aKcnQVjVrvb2PkzeGU-7ZRbsBgZw
https://lh5.googleusercontent.com/QjajQPBQxJ5eqFAdRj4Mzk4-7XRT-l3oNnOocYhBtkNLxkOEMWx31I3ROaCSuQKIfJ0pjVsff97MaxIhRL_Y8lgCKOtev7wdAbbidAb6tLddZbRl4hxSzxiq6LkAmxU4bN8xzXQ
https://lh4.googleusercontent.com/OeYA5GdM6fS48IvKdOnNQ1ohEf-gPAwdfZcxO8iu_biZGxC9uYnaAc0onTM6gJk8omx1Ci8piRzWhj0UjIkfBnabh9ZC2ovJIj8BQs1zqlRq9KJhEB1tTEdEyZLQUT6P4XgaK68
https://lh4.googleusercontent.com/P_q0CYwxfLLZ_GxJS8xyzQ034boP3heornvpAprNmOjQKlDZr9OX_9UGVJZ-TQklCZ-Npsxg03JQZa1S-fZFbr4HFFRG_Mr6fZsOAHRl8lNc8dYBIcox3YIkk9x0thJ_-EH2Du4
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blocked URL

Once the desired BP is found, double click on the line.  That will return the session to the main BP screen having populated the ‘Parent B. Partner’ field.

Appendix 5 – An ‘Invoice-to’ role inactivation (realized by Credit Control)

NOTE! DMO has Read-only access to the ‘Invoice-to’ role – it is maintained by the Credit Control. 

‘Paying’ tab

Terms of Payment: if not CWO, change it to CWO

blocked URL

‘General’ tab

End Date: today’s date

blocked URL

Clickblocked URL.

Next, click on the blocked URLicon. 

Enter a note in the Text Editor. The verbiage should read “Date: Inactivated acct due to lack of sales activity for 18 months.  Full acct review and PO copy must be 
received to re-activate … initials.”

blocked URL

Click blocked URL andblocked URL. 

Appendix 6 – TradeBeam

Upon creating, activating/inactivating a BP in BAAN or making any changes, the BP is automatically sent to the Tradebeam in order to perform a prohibited party 
search. 

Until the Tradebeam has released the BP, the B. Partner status will show as ‘Inactive’ and will be grayed out, while the message “Pending verification from 
Tradebeam” will be displayed at the bottom of the screen. All BP’s roles that are pending the verification will be inactive as well. This is what it should look like:

blocked URL

NOTE! Do not close the ticket/inform the requester that he can use the BP until it is released from the Tradebeam.

When the verification is received, the message should disappear and all roles, as well as general BP, should show as ‘Active’. If it doesn’t happen for a while try 
closing the BP (saving all changes beforehand, of course) and opening it again.

If it still doesn’t help, you should check the Tradebeam history in order to determine what is going on with the verification. In order to do that, click blocked URL 
button in the general BP. This will open a new window. 

In the menu bar, select ‘Specific’ ->’ Display All’, and afterwards select ‘View’ -> ‘Sort by’ -> BP,BP Type, Address, Trans. Date (the first option in the list). Click on 
the binoculars blocked URL and in the nest pop-up window:

 enter the necessary BP code in the ‘Business Partner’ field
Select ‘Header’ in the ‘Business Partner Type’ field (or any other header for any particular role that shows inactive)
Clear data from all the remaining fields.

Example:

blocked URL

Click blocked URL and this will take you to search results. At the top of the list you will find the requested BP and the last column ‘Status’ will show the verification 
status of the general BP and all its’ roles. Here, for example, you can see that the general BP and all its’ roles have passed the TB, except for the ‘Sold-to’ and 
‘Ship-to’ roles:

blocked URL

If the ‘Pending’ status shows up for longer than it should (a day, or a day and a half), or if the status is ‘Fail’ or ‘Lost’ (also longer than a day, or a day and a half), 
you should turn to the TradeBeam support team (depending on the system and on Cytec entity):

https://lh3.googleusercontent.com/2uprEeOb21rDyYOti1ADJ2Lh-yn3uEEFYp0c5f7xcRQ6r_pKkyRE6TmcpnrM0NNRMNwHQ_Y5wMHu9-ilT2x1mdUt36hlEyPZTpevE76ZWR04sN-_HfW-DDQM2ec2yVB04er2f2k
https://lh3.googleusercontent.com/3CBZhnXyd4DMVmP5Zllkj9ENlRgXyopp-omDN7MloxwGuun4fl_5nOtRbPfP8pK4TN4gI4kSd8n-snvwoifNHsWDh-PImrgwx1ozADM4L7ppqCH3tQ5eTz5_M47q0FWsxFt0BfY
https://lh4.googleusercontent.com/rYI7-D8RILHODIUa4YdQJWRZJYZQI5D_c23XXRRa7rP8RWt9nCWi_a_DeGMMWYR5tG5mJ1WFLsRd8_vmSLm6NeruCfZ-ivKiAs7dJOlj7m0ngJPiknH7DFzT2m5VLlxzH2q-RZk
https://lh6.googleusercontent.com/jdlmJuZbXPURHhJ1TmzhqV_CEa0JglUSnylnakmnUBpOSZxVDrq2eiu_tqYUfc-n8-rkqnxIZ4dRZvp6dH4iE-k4kW0k-Lsx_G4VbBguLoT7BlrgRvJjCsltKyvxEoBlQwpZbeA
https://lh6.googleusercontent.com/OFubuQ3cz4vxxqFC6ehCgURtTa8AydYJgz1q7qCRaNBZyQWETuwVW-5eYWzlB-AiEItwNkO2CDOMDAdWY-yEBxmEA_chE6SNqcJlSc0jUwnSJc17d-maMmT1qiLT16Ej-GqeyEo
https://lh3.googleusercontent.com/C-3N_-BR2I9KwxvTU-LCBxPRjyQKKyRKo6lUCgdoOpfmsjWUbKabC-9ngg03wmLydu4VBmGkxAP3DtfUWtMw0gDDgZ7ob7QJHJjF2ngM3Ma4A7QDMP2wRlOZ81QBeEjz-u7UkSI
https://lh6.googleusercontent.com/RwJlbkBqmH3xvGMS3MOmtVWmfvEQLatJuiX7eRtK4CK9H20CvIa6928oGL4wPqmm9vEwIELeWQVeCod0hU_s5bHxy2BbLsUf4gZWEUkOXiEfAdQ0LfZj5na30MR4yKS4KUYC_t4
https://lh3.googleusercontent.com/Ty05ODqBeakVshDtkMSzBMWCwjcqM37c5gricMKgOXe24VivBel0VrfJBj3ajGVr3koF9O1yBQti2SjDwPo_i_21ZKl3Kwe15Cr8vsO-876t084QOyDHuUrLJZohZtsgyil4dp8
https://lh3.googleusercontent.com/tCZQUmzgRgoRxvdOp3NZ9EO5wywqx5EzT3KqBl6gxbGjEUV6vz9-HZJ-jLv08ctYR28b4nOTr8s7DBLz1NSXrl5C8djXaEAgEHPuX7eP9JHnGhmSzRhKYb6NuIYAzG_fsgMc6ZE
https://lh4.googleusercontent.com/aQv15whl_dD9WygOybS8b2lk4JBCt6RlJiVY5WmmNWKjWxmDC62iL5ZaueUYChV52oXr4jWQ4B7XSTx3TjoYDH9xi66St0dAI3sppCIQqAWcuO92r8y2hr_Zzzpl9eqZt912XG0
https://lh5.googleusercontent.com/t8H3LHGLE6KGppl29LYQQtecBKKYA4oMPZNtu9nElnbbp6u7yag7ve8p7ZRTFQzyBUhUZKroKgF1RBI773AzfgX0Nm0d6hrRMP2pw8VrrHAYoZUNBzT6LiZHqMxvbNuzqVox850
https://lh6.googleusercontent.com/mmqG4B52dR29ozg_Af25ecP2HHcl4hXW727Fa6LnSAhFlzVb-trCCiAxU-GKGMq8b6B1sjsJDHvZxS4JqX6z1jFB-enAAOx6fIa0n2nemLAEHfgKIwBL3szXz1YBpkU3E2opXvQ
https://lh6.googleusercontent.com/M40_ifqfjaTGpmgAphpM-JqD8XsghfR5TYrzDaOc6wDQ1M6wleNHAXpL--g7w64BeSSx4PQZlVAglCoO7_yA4O47QGvRTPyZ63mm8m8siJdcDi3UymOi05MkjP0HFfZkoRnEwSc
https://lh4.googleusercontent.com/3t_nITGc0rcoWVptXoNYLsnqePq0BH0KEmsV30ZZXhLKQqFUN6VXlKxqObm4rrlF4Bts9Ej7qzke94J4ngwWhM8jhdnBgfNDMw65dnyRG_CpZxXDLL6AafSdKUAlJTFUTLNeXlU
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System Region Person responsible

BAAN

NAM/LAM/

Europe

EU Customs and Trade Control Team trade.control@solvay.com

APAC Diane Giglio

Appendix 7 – A ‘Debtor in Possession’ customers

Sometimes we can receive requests to set up a ‘Debtor in Possession’ customer BP.

In the majority of cases this will be an already existing customer in BAAN, who has filed for bankruptcy and we need to set it up as a duplicate for the ongoing 
businesses (to avoid mixing up old and new invoices).

In such cases please create a duplicate of the existing account (with a new BP number).

The only difference is that in the name of the BP itself and in its’ address/addresses there should be a note “DEBTOR IN POSSESSION”. For example:

“AMERICAN AIRLINES (DEBTOR IN POSESSION)”.

Or if there’s not enough space - “AMERICAN AIRLINES (D.I.P.)”.

Name “American Airlines” should be logically replaced by the name of your customer.

For this purpose we should always create new address/addresses as well.

Appendix 8 – Intercompany setup specifics

There are two things different in the intercompany customer setups in BAAN.

‘Search key’: if the BP is a CEM, CYT or SOL (Solvay) entity the search key is CEM, CYT or SOL/ Entity number  / location or name of a BP – please see 
a list of examples below (the principle is the same for both vendors and customers):

blocked URL

When a new Intercompany customer/vendor has to be created and a corresponding trading partner (Fin.Suppl.Grup) number is not in the system proceed with the 
following steps:

BAAN:

1.Trading Partner can be distinguished by the last sequential number available in the table

For Fin. Suppl. Group. creation contact:

Elza Gierkena for companies 100,160,188,187,189;

Letitia Lemay for company 775

Provide them with entity name, new entity number, Solvay company code

NOTE: BAAN trading number and PE1 trading number should always be the same 

The Financial Group in the ‘Invoice-to’ role (Invoicing tab) should be added by Credit Management, once created. 

blocked URL

NOTE! Even though Credit Control doesn’t deal with intercompany customers, and theoretically we don’t need their approval to set them up, we should still request 
them to complete the ‘Invoice-to’ role for such accounts. 

Intercompany payment terms should always be  NET1 (DUE ON RECEIPT) for Cytec.

ALSO! For intercompany setups there is no need to request the usual documents (a customer verification form, a copy of the PO and bank/trade references).

In case you have created new Solvay intercompany vendor or customer in our Legacy Systems, please inform Karlis Dzenis and Anete Laksevica and provide 
following details:

-          Vendor or/and customer;
-          Number in the system;
-          Name;
-          System;
-          For which company vendor and/or customer was created;
-          Solvay entity number.

mailto:trade.control@solvay.com
https://lh3.googleusercontent.com/lwVqS4p0SdV_r_bdr5XcaGITJvP0fUydB6aPyB7UoxY4jB_VqEw5kOe_G05fReINEkKPMNlK5ffbwPGHZiSevDX7NOaanrb4wtTH4uv5WxxIuB4Jl3UF4A5Bx0RndAWLqWLJVVI
https://docs.google.com/spreadsheets/d/1BiMPDqctjFMix0EHfRCkuuGrd2SeQaa9UTA7s0-ju-8/edit#gid=2082713720
https://lh6.googleusercontent.com/TBbcEscuNrfCK575a6Q574p6V-3ZwUVCNBvqh4AjAQkmRa0k-CFKCVL18q6JuimBP4d7YJB3cjOTeILO6EnMXB4Nyx15WcwRo0yGVs1pC7ERmZ9chCLTpT0iKX_YI3OzhhGlXJk


Page 20 of 23

This document is the property of Solvay. Any reproduction or communication to third parties is only possible with the company’s authorization. This 
printed document may be out of date. Please check the latest version on the Intranet.

1.  
2.  

1.  

1.  

Appendix 9 – Setting up customers for Co: 775 (China)

Customers requested to be set up for Co: 775 (China) can be not only domestic (located in China), but also export (located anywhere else). Whether a non-
Chinese customer needs to be set up in Co: 775 or in Co: 100 can be determined:

By a requester or his/her location (the most common requesters for Co: 775 would be William Chen, Rebecca Zhao and Cheryl Wang), and/or
By a company indicated on the request form (field only available on the Co: 775 form).

If you have any doubts, it’s always better to contact the requester and ask which company we should set the data up in.

The main difference is that customers created for Co: 775 will always have Business Partner numbers starting with ‘805’, and address/bank/contact codes starting 
with ‘CHC’. The approver for Co: 775 is  David Stephens. 

For export customer setups in Co: 775, there are no drastic changes to the Co: 100 and Co: 187 setup/maintenance processes – please follow our Work 
Instructions for the required field values.

For domestic customers setups in Co: 775, there could be two options:

If the currency is anything other than CNY no additional setups are required (please follow the normal processes described in these Work Instructions)
If the currency is CNY a few additional steps have to be performed (in this cases customers are sometimes referred to as ‘golden tax’ customers):

There has to be a tax ID provided to you by the requester (with a copy of a tax ID supporting document), which should be entered in the ‘Tax 
Number’ field in the address codes and on the main BP level.

A Chinese translation of the data should be uploaded into a separate database. These translations are crucial for the VAT invoicing and tax 
documents. In order to do this, please check that the Chinese translation is provided on the BP request form (if not – go back to the requester). 
After you complete the setup in BAAN, copy and paste the Chinese translation into specifically designed Excel templates (one for the main 
Business Partner, another – for all address/bank/contact codes; see the filled in template sample below) – the templates can be found at X:
\DM\Templates\C2C (please don’t forget to remove the pre-populated data which was left in one of the templates for your convenience). 
Afterwards send the templates to Oleg Korsunsky (at Oleg.Korsunsky@cytec.com) from the IT department in Tempe who will organize the 
upload. Please also save the filled out templates in our Customer request folders with the rest of the documents.

blocked URL

2.3 If customer banking information is provided, it needs to be entered in the system and translated as well. Data Management does not have access to adding 
customer bank data, so you need to turn to Credit Management with this (granting us access to this functionality would be linked to the ‘Invoice-to’ role access). 
Before sending a request to Credit, please be sure to find/create a bank address code in the ‘Addresses’ menu:

blocked URL

blocked URL

In the ‘Addresses’ selection menu try finding the requested bank by its’ name or the address (the same way as we search for addresses):

blocked URL

If you cannot find the requested bank, it needs to be set up.

2.3.1 Setting up new bank address codes

In the ‘Addresses’ menu click on blocked URL and in the following screen complete as follows.

blocked URL

Address code: CHB

Name: Bank name

CAPITALS

Search Key: Check the key defaulted by the system and correct if necessary

CAPITALS

Country: Select  blocked URL and double click on the required country code

Address: Bank address (if available)

CAPITALS

City: Bank city (if available)

CAPITALS

The remaining three screens can be left blank.

As soon as this is done, click blocked URLand a new bank address code will be created. Don’t forget to take note of the full bank address code ID as you’ll need it
after:

mailto:Oleg.Korsunsky@cytec.com
https://lh4.googleusercontent.com/7ucG8UULPOO3YPzuPvAO2SyfhdlbeBFI2cp9Yd_Rowtq8KDKH2-3klMBi54HLiYCDDheKP-iuaXrzi4QRF5wcUhLNA5-U4jc0RLGQ5bFn-b_ZzTaTH1IHl2cw-6vufNm0wxSPUk
https://lh4.googleusercontent.com/clrd3hhH2OzNY8XsRa_FSu2FWFJlLgZAh-BEJi4pH3uxUOKvOW8TXK8qWQvi1bfk4tXRdyqlpO_KRrAIpT3yEGSgXuM8ZdfvXP8jMMbIepWEoSoGpOejD7ECSCCCvhRijzwV7gc
https://lh3.googleusercontent.com/1I6ParridWRxVZjQMBNxwCx-0CGNQXGEuXUY6tOGPtkXELQM1msAChnJix3cNTXR-HtkgH39njpi_oqOd6E1Pqb5aQTy0gKF2UmB5NHnv00Ha6dX2gzL30896qYWQGb5Pv9xsN0
https://lh5.googleusercontent.com/5uRftKW64oP4SzOdMqHJcQ28jUBSihQxJWKwJ03O5v6EYKEj9uZ3Z5K5Tuc8MrO8OCsGBDDIOpV1HmTz5wgjRpvnOFQKZumQCUcCnot5B8VtNnPF_fByIFVvpn9lq3vDZT4Qh-Q
https://lh4.googleusercontent.com/3wXlKP7kpNrbX4VTtM08FE2iSJ6KpV3WUVVAP4-hsu7mZTTBsGTjmNpt-3hD2-s-eWGaC8_goJh03N4d4r-MS7rfGyR_4tCnQBpimBD7gRoIdyWcP1jnxUPKFekq9f9CZ483OYI
https://lh5.googleusercontent.com/xUaboOszjd_fVoG2QUXAEQrTANneJ0nBm6szKX4bqaUEU8h4IhjrDt-ZKFip-uTGzHePy2xBFFqH4gpIqqEO-hlCD-o79grA3N9fYgwbv3O0JfpTkYZS3mAozjixuLPiXpwRVLo
https://lh4.googleusercontent.com/btQLiAPs6toXHovv2fYYypP9Mt40bL1BJ_hhuJEN9EkiaGx-l_p-iVDNo1xHCQZ5dyaY9XJhWGQ58EKboBRxm_2xMyynDrJyMK7nkolxoJZIkDdqZIQxoDhnv1h02Qd7juEpaPo
https://lh5.googleusercontent.com/gf7LNVRhDio4B2Wp7qKDR18YITFtK9wNEpKDrXPJU7PUu7Cm24A5aYk7GqjtHXLtN1pdiT7Ph1h763UwoIo-0uUqa0bikJsJibkJl0eqSBfP1YWhCrOwsmnbWX6MbQAuPl_taL8
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blocked URL

2.3.2 Adding customer banking information to the ‘Pay-by’ role

As soon as you either found or created a requested bank address code, you need to turn to Credit Management’s help with adding customer’s banking information
into the system. Please send them the instructions (with the screen shots).

blocked URL

In the ‘Pay-by’ role please click on the arrow next to the ‘Bank’ field and in the appearing screen click on ‘New’:

blocked URL

Then the following screen will appear where bank data should be set up (please provide Credit with the correct bank account number and the bank address code 
you found / set up; ‘Bank Type’ will always be ‘Bank’, ‘Account Type’ will always be ‘Normal Account’ and the ‘Bank’ field should be populated with ‘TR1’ if :

blocked URL

Bank: TR1 in most cases (stands for ‘Transaction 1’, meaning the first banking details added to this customer; in case there are any other TRs already 
in the list, the next sequential number should be selected, i.e. TR2, TR3…)

Bank Type: Bank

Account Type: Normal Account

Bank account: Customer bank account number (please provide Credit the number)

Address code: Bank address code that you found/created (please provide Credit the number)

2.3.3 Uploading a translation of the bank details

The last step in setting up customer banking information is providing the translation templates to Oleg Korsunsky. For this please copy the provided banking
information into the ‘China-AddressConversion-OlegsTemplate.xls’ form (together with the translated addresses) and send the form to Oleg. Both forms
(addresses + banks and customer name) should be sent at the same time.

Appendix 10 – Changing an invoice delivery address

Unlike for other systems, in BAAN we don’t forward requests for updating customer invoicing addresses to the Helpdesk. Instead, this is what should be done:

Go to the ‘Contacts Maintenance -> Contacts by Business Partner’:

blocked URL

Search the Business Partner number (click on the ‘binoculars’ and in the next pop-up window erase any data from the ‘Contact Code’ field, enter the 
requested BP# in the ‘Business Partner’ field and click ‘OK’):

blocked URL

A list of all contacts currently assigned to this BP will appear (check if the contact already exists - it should also be checked for the ‘Inv. To’):

blocked URL

 If the contact doesn’t exist, click onblocked URL and on the next screen, select blocked URLnext to the field Contact Code:

blocked URL

After this we either need to find an already existing contact code, or create a new one (in case it doesn’t exist yet) – theoretically a contact code can exist but not 
be assigned to the requested BP yet, so it’s important to always perform the search.

Checking if the contact already exists

blocked URL

Select ‘Sort By… -> Search Key, Contact Code’ and click on ‘Find’ (as shown on the screen shot above). A search pop-up window will appear where you need to 
complete fields as follows: 

Contact Code: CUS or CHX for Co: 775 (to sort only the customer contacts)

Search Key: part of the name (usually surname of the contact)

blocked URL

Check the appearing list. If the contact is within the list, select the line and click on ‘OK’.

Creating a new contact

Select blocked URL and on the screen below complete as follows:

https://lh3.googleusercontent.com/m7Eh0pWIpt9DKBC5u9aayYMX18NzaflE846ZciQ3V_PJVas8I5FREEcXRgv5shY-TRywrxDtg2QgVr3Zh_7AKG8CuvcnChqTUvex7vdljalo6zYtrBGO3M3_4LSwjsxOxVD4bjI
https://lh5.googleusercontent.com/2GXTbK1Pnl6nsEsIzFEPkoQrefWA8Q-xJOhwpKJJH0O08hdHHU_nKokhEt68xza9CffFUYsMZf5egiQoGQqQWPgOi2c4hE16MY0RMrxauuPjkuwUVIeiRwloykrv6u0prj78PNY
https://lh4.googleusercontent.com/UnFfcT7InGkFrrfKXv19SD1eoSyJLBkIygaMrdcGTNbRXPbc6wyZJt3K7YohVat5djcaIWe4zB7UBKwYyBsH_ipHkIOvhz2x_HbN7eyffz6Yv02CmiZxkb1q4x4ajA-9qj9f9X8
https://lh5.googleusercontent.com/Lf2TNFJd911ny_4N6NjHWMWatXad_YRBRajPEsyrLlM9GX6ACpGcMQH_342DKrkyeJkO4SUR6z-58tZdmATauJ_nHurciTJAv1t6ffmBgphPnmgaKS1_CS4srAG8HU2fLSdRRBQ
https://lh5.googleusercontent.com/w4j58ZlAMGRUj9aSkYb-Jy5VpWtKqsWn4OL9nPmIo9l37qMmXs7G5KzVzvRhOv9RTfZKY5e7Rb-O_caVIaCe6Q5eMaVnAhkiQm-Gbcm97xjqIuRuU1nnTM3uXTydR0tHW2iVAlo
https://lh6.googleusercontent.com/Csx031P3Adh_MPsEDb6V6Uwmy1kndz0oqzYSHluDx7dEtosV2DN1UHFHrkgs4Xp1QlNUPUOAoc046--Cef4RxjQuwNIRykjnrptWfDselCqgLwWCEJXcd64ncj4743LpRlpJ4Xw
https://lh5.googleusercontent.com/ON0BY8fgHoADdVZYpasy64S9rbwxL7srKznUd-cJTIZcJX209i0x6Mn6uTGenb_BOv97DHuXFNVQ9iOKY7rx8kXewFr8mbb1a8vnO-etKPXOBjj-wMHwzuc4dRiwaiWhriP-6WA
https://lh3.googleusercontent.com/9K4RB-siTJO-awcr5bjLeKxz_budrxSlGhL_YJ5fisBE70tDpO11y_y-oLty2RtCoY1JvqEZ6YhjasLF4xtbPCYLxsfFgnWlExtRhcyuhWHSaM-3u-lYY8HAGt2JK04xvCYEKsg
https://lh3.googleusercontent.com/bSx709x0tcFS0vn32yWHgAYq2VKr0nTEF32yclccqbn-QzYyA3Em3wZpYteeFDTQCVObd54EPFsBL81_7N-a3WEYYZnJ4h1iuXhU-uxfDWrjSZcpzN7hYbX6Q88OY6Jw3wQPfis
https://lh4.googleusercontent.com/ECEXLK0-kxJ86lJRcfqrEgfVtzulBL-XzDnUpkEDuRkM3Wg__SYQT5-J7paRuHznheV23R__OGMVrpzs5j6xa1WN5ofMJBXqE1AfcZQQkbDMvvXnoSNRq2gMSK0-6xlQqQar_gM
https://lh6.googleusercontent.com/2m4Thmf_0sxr7F5CuUsb6iKFEsWSvXwW4GWQKQoT1DBdbz2pEWAcxQfpbVVcF38qD0MCKraAmPKbnB19m2HYuBxbsbYJ6q63h9QQO7GWUnVfzkH4qgoZjKDI_67GpX0XD2BEC1A
https://lh5.googleusercontent.com/22cMwhJ5kbLdWU5GrU6ANQkBYipoOIPIC1nulmnc0fX9vBfyXILIFPSO28Lqyk_F3TBRLovRYm2aRsp9ctb6praSm33qPT7M5zP9WR5pZCJv18TWSvz4M1Rx-K5fsfk3FK8glRE
https://lh6.googleusercontent.com/LJBiFJsLiZhRwUVtdkLbvIaXCeSMSM_myhlVbzOThGE2RRGsgOpo3Q0GEqLRPpHBk9qqSiReu-tng2AKe_SQ7rv3dbGo0DAvAE_4tTOmIH-5Q7dtD7In_kbK3FtE7us9GGxMMdo
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Contact Code: CUS or CHX for Co: 775 (the sequential number will be generated automatically, the same way as for address codes)

Surname: SURNAME of the financial contact 

NOTE! Please use common sense – even if name is not provided separately, it could still be readable from the e-mail address!

First name: NAME of the financial contact (if available)

Search Key: SURNAME, NAME (the latter - if available)

Finance Company: all company numbers  "1*"- old way of creating: 100,160,187,189 (separated with commas, no spaces)

NOTE: in case we are requested to add new recipient to invoice distribution list and it's indicated also for co:188 then following setup should 
be in place in order to cover all financial company codes; instead of listing all companies in Finance Companies field "100,160,187,189" 
please use  "1*"

Telephone/Fax: the phone/fax number of the financial contact (if available)

Formats –

For US and Canada: ‘country code’ ‘space’ XXX XXX XXXX

Rest of the World: ‘country code’ ‘space’ XXXXXXXXXX.

E-mail: the e-mail address of the financial contact (if available).

Click ‘Save’ and ‘Close’.

blocked URL

Select the line you have just found/created and click ‘OK’:

blocked URL

It will make the found/created contact code appear on the following screen:

blocked URL

Click ‘Save’ and after that check the box next to the ‘Invoice-to’ role:

blocked URL

Click ‘Save’ again and then ‘Close’.

NOTE! When creating a new contact, please don’t forget to uncheck the ‘Invoice-to’ role box for the old one if it is no longer valid.

Then please go to Invoice-to role to check which Inv.Delivery method is chosen for this Customer account and whether it should be changed.  To determine 
Invoice Delivery Method in Invoice-to role, please check the list below. Also, when we receive request to update Invoice Delivery Method, please check Invoice-to 
role BEFORE sending to the Credit, as sometimes it is already correct. 

Invoice Delivery Method options:

Blank = post
600 = email only
700 = email and post

blocked URL

In case Inv.Delivery Method should be updated, please forward this info to the responsible Credit Manager. 

Appendix 11 – Non-trade customers

If you receive a request to create a new non-trade customer in BAAN, please note that there are no differences setup-wise between non-trade and regular 
accounts. The required documents are also the same as for the regular customer setups. After a new BP is set up, please inform Credit Control for them to 
approve and complete the ‘Invoice-to’ role, and please make sure to mention that this is a non-trade account (they may need to indicate this somewhere in the 
‘Invoice-to’).

Appendix 12 - Credit Control representatives

Customer location Contacts responsible

Co: 187 (customers located in Europe, Middle East, Africa and not created for China – Co: 775) David Stephens

https://lh5.googleusercontent.com/APJ0Zo7z0QeEA7TnCd7FCTd7mN03O_r50EheaOXoYTXobrMN26m_W2w4DiX1ZAWoRqZ2h_Rn2kVvrMj7ob-r3oID_y-H_cAgVAJikHeDnsZzxksvaEgm_t48sAbnT0fQ_lDlDVY
https://lh3.googleusercontent.com/UIP6w9-_JAFO6XIRs1EDfSZU9F4UBhLxWXgtBVQWr1z7_tG0Nu7TrX4tY2hcK8vCnHQP-9Dt-8u08U_1XRg1RupN8ZapA_A415oUUuKccgQVlnKfS0EJd8oAG1giu6cDkPXALQY
https://lh5.googleusercontent.com/m34CzGWc6uBOrJ5cDEbapZAOOAlEMTAMtNb7wOTviCO86xmlRYVGqFU4ewWsz7QDpYBBxAo9O134C-COvAif6NLhNNUwRfu3OPipFrMsv5y4ajtlSVC1woMO1JNiXM4FnFpCeRY
https://lh6.googleusercontent.com/orGCguLrYbfrE7nqtaxudpJiHEaVjXoDZpMQaku1yBtcNSlQqxt2BrISAI46pfx39ymRhxsjBfJ4eGY08282JQ4CiP8oeFEi36ZLf5nHr-7HuGOjplet0eY7Rgut9yMA7g8EZjo
https://lh3.googleusercontent.com/4bNI_-zXuLAlrjv6sAxd7rm7VZywiAuQoMakqkpqsnz1eA82c0ehtEe1oOmvmDqktMV-pqpXKFUqL3nsbOSLiMw6EZ5XggdImmHWSfKj6gsLXCYeJZR4Bae23bfQNz9Jvr9nQJ4
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1.  
2.  

1.  

1.  
2.  

1.  
2.  

Co: 100  David Fritz (customers located in the US, Canada, Latin America) 

David Stephens (Asia Pacific, Australia, New Zealand) 

Co: 775 (any customers created for China) David Stephens

Appendix 13 – Required documentation 

 New BP Set-up / Re-activation

New Credit application form (to be filled out and signed by Customer).  
Bank & Trade Reference Form – mandatory only for US.

Can be customer’s own form submitted or filled out in Credit application. 

Copy of the Purchase Order

Correct terms must be stated on PO – final terms to be determined by Cytec Credit Department.

If PO is not yet available (BP has been only quoted, sample orders etc.), letterhead from BP will be enough.

BP Name Change

Official letter supporting the change.
PO (if available).

Address Change

PO, Letterhead or e-mail from customer can be accepted. 

BP Update/Change

Purchase Order, Letterhead or e-mail from the customer is acceptable.

New ship-to BP / ChangeAddress can be provided in Freshdeskticket description. Purchase Order or e-mail from the customer also is acceptable. 

Active SAP customer extension to BAAN

Copy of the Purchase Order
If PO is not yet available (BP has been only quoted, sample orders etc.), letterhead from BP will be enough.
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